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NetWitness Suite System Maintenance

This guide encompasses the tasks that administrators perform after initial network setup to allow
NetWitness Suite to manage hosts and services in the network, maintain and monitor the
network, manage jobs, and tune performance.

The following diagram shows the different system maintenance tasks available to you.
Troubleshoot

MetWitness Suite
system issues

Review system Monitor the health Locate and view Maintain queries Understand FIPS

support

maintenance best of your NetWitness system and service used for
practices Suite hosis logs investigation

The following topics describe these tasks:

e Best Practices

e Monitoring Health and Wellness of NetWitness Suite

o Displaying System and Service Logs

e Maintaining Queries Using URL Integration

e Managing NetWitness Suite Updates

o FIPS Su[g[got“[

o Troubleshoot NetWitness Suite

7 NetWitness Suite System Maintenance
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Best Practices

Safeguarding Assets with RSA Supplied Policies

The purpose of the RSA Core Policies delivered with NetWitness Suite is to help you
safeguarding your NetWitness Suite Domain assets immediately (before you configure
rules specific to your environment and your Security Policy).

RSA recommends that you set up email notifications to the appropriate asset owners for these
policies as soon as possible. This will notify them when performance and capacity thresholds are
crossed so they can take action immediately.

RSA also recommends that you evaluate the Core policies and disable a policy or change its
service/group assignments according to your specific monitoring requirements.

Safeguarding Assets with Policies Based on Your Environment

RSA Core Policies are generic and may not provide sufficient monitoring coverage for your
environment. RSA recommends that you gather issues over a period of time, not identified by the
RSA Core Policies, and configure rules to help you prevent these issues.

Creating Rules and Notifications Judiciously

RSA recommends that you make sure that each rule and policy is necessary before you
implement it, if possible. RSA also recommends that you review implemented policies or a
regular basis for their validity. Invalid alarms and email notifications can adversely affect the
focus of the asset owners.

Troubleshooting Issues

RSA recommends that you review Troubleshooting Health & Wellness and Troubleshoot
NetWitness Suite when you receive error messages in the user interface and log files from hosts
and services.

Best Practices 8
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Monitoring Health and Wellness of NetWitness
Suite

The Health & Wellness module of NetWitness Suite provides the ability to:

o View the current health of all the hosts, services running on the hosts, and various aspects of

the hosts’ health.
o Monitor the hosts and services in your network environment.
o View details of various event sources configured with NetWitness Suite.

o View system stats for the selected hosts by filtering the views as required.
In addition, you can configure Archiver monitoring and Warehouse Connector monitoring, use

the procedures on monitoring host statistics, and work with system logs to monitor NetWitness
Suite.

Note: All users have permission to view the entire Health and Wellness interface by
default. The Administrator and the Operator roles are the only roles that can manage the
Policies view by default. Please refer to the Role Permissions topic in the Security User
Management Guide for a complete list of the default permissions for the NetWitness Suite
Interface.

The figure displays the Health & Wellness module of the NetWitness Suite user interface and
various sections in the Health & Wellness module.

9 Monitoring Health and Wellness of NetWitness Suite
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Health & Wellness

Alarms Policies  System Stats Browser  Event Source Monitoring
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Event Stream Analysis nwappliance7430 1031125471 :—
Broker stopped
Broker
‘
)
| Page 1 | of1 | | ¢ ™ AutoRefresh Items 1-130f 13
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Manage Policies

Policies are either user-defined or supplied by RSA. A policy defines:
o Services and hosts to which the policy applies.

o Rules that specify statistical thresholds that govern alarms.

o When to suppress the policy.

o Who to notify when an alarm triggers and when to notify them.

For the related reference topics, see NetWitness Suite Out-of-the-Box Policies

Note: You can now configure a policy to notify Public Key Infrastructure (PKI) certificate
expiration status.

Add a Policy

1. Goto ADMIN > Health & Wellness.

2. Click Policies tab.

Monitoring Health and Wellness of NetWitness Suite 10
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3. Click + - in the Policies panel.

The Policies view is displayed.

A list of your hosts and services displays for which you can create health policies.

Alarms Monitoring

Policies
+ = I

Admin Server

LT
o

Archiver

Broker

Concentrator

Config Server
Contexthub Server
Decoder

Entity Behavior Analytics
Event Stream Amalysis
Host

Investigate Server
IFDB Extractor

Log Collector

Log Decoder

Mahware Analysis
Orchestration Server
Reporting Engine
Respanse Server
Security Server
Warehouse Connector
Workbench

Policies

¥ [ JWarehouse Connectar

¥ COWorkbench

4. Select a host or service (for example, Concentrator).
For PKI policy, you must select a host (for example, Host).
The host or service is displayed in the Policies panel with a blank Policy Detail panel.

11

Monitoring Health and Wellness of NetWitness Suite



System Maintenance Guide

Policies
+o =1 ® X
b [0 Archiver
¥ [ Eroker

4 Concentrator

@ 54 Concentrator Monitoring Polic
i ¥

ol |

5. Enter a name for the Policy (for example, Concentrator Policy Status) in the Policies
panel.
Policies
+o=-Z | ®
b [ Archiver
¥ [JEroker

4 & Concentrator

@ 54 Concentraror Monitoring Polic
i ¥

C[Cﬂnce ntrator Policy Starusl ]
The name (for example, Concentrator Policy Status) is now displayed as the policy name
in Policy Detail panel.
6. Create a Policy in the Policy Detail panel:
a. Select the Enable checkbox.

b. Add relevant services (in this example, any relevant Concentrator services) that you
want to monitor for health statistics.
For PKI policy, you must select the LOCALHOST to monitor for health statistics.

c. Add relevant rule conditions you want to configure for the policy.
d. Suppress enforcement of the policy for the time periods you want.

e. Add any email notifications you want for the policy.
f. Click Save in the Policy Detail panel.
The Policy is added.

Monitoring Health and Wellness of NetWitness Suite 12
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Add Policy Example

Below is the high-level example for configuring PKI policy:
1. Add a new PKI policy.

ADMIN @ (D admin

Q0 HEALTH & WELLNESS | [ @
Aarms  Monitoring [EEINUSSCR System Stats Browser  Event Source Monitoring  Settings
Policies Host: SA PKI save
o -Z 1 BY M Enable Last Modified:  2016.05-04 03:51:14 PM
» D Archiver @ | | Hosts
» ClBroker @ | Choose the hoss, senvices, and groups that your healh policy applies o
» Dl Cancentrator © +-
» C] Context Hub © O Name~ Group Type
» [(JDecoder o O LOCALHOST Host
[RRSTOE. |, P o
Rules
Ao © | | Define the conditions under which you wart to trigger an alarm for the Security Analytics health problems (definiion includes severiy, scatstic the alarm applies o, threshold, and threshold atwhich the alarm clears). Afer you define the
" alarm rule, enable or disable the alarm.
4 Host Monicor
SAPKI + -
» [J1PDB Extractor © & enovie | Name ~ Severity Category Statistic Threshold
» Clincident Management o ¥ Alert When a CRL Expi... ~ Critical PKI SA Server PKI CRL Expiration Alarm <=0 for 0 MINUTES
» DI Lo Collector o
Policy Suppression
» CJLog Decoder ) Y SUPR
Define the time periads to suppress policies.
» CMalware Analysis o
+ TimeZone: | UTC (GMT+00:00) ~
» CIReporting Engine o
O pays Time Range
» CIWarehouse Connector o
Click on + to add suppression to policy
» DlWorkbench o
Notification
oz I L o desinanon b

2. Add a Rule with Statistics:

o For CA Expiration

Enable ™

Name Trsuted CA Certificate Expiry Time

High v
PEI ~ | | SA Server PKI Certificate Expiration ~ | TRUSTED_CA ~

o= w2400 For 0 £ Minutes

» v 2400 For Minutes

Time Zone: UTC {GMT+00:00)

Click on + to add suppression to rule

Cancel Save

o For CRL Expiration

13 Monitoring Health and Wellness of NetWitness Suite
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Add Rule

Enable ~
Name CRL Expiration Based On Time
Description

High v
PKI ~ | | S5A Server PKI CRL Expiration hd

= ~ 2400 For 0 £ Minutes

W
<

For 1 < Minutes L\\:

Time Zone: UTC (GMT+00:00)

Click on + to add suppression to rule

Cancel Save

« For CRL Status

Add Rule

4

CRL 5tatus
Description
Severity High v

~ | |5A Server PKI CRL Status hd

~  Valid For |0 £ Minutes

~  Valid For |1 £ Minutes

Time Zone: UTC {GMT+00:00)

Click on + to add suppression to rule

Cancel Save

« For Server Certificate Expiration

Monitoring Health and Wellness of NetWitness Suite 14
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Add Rule

Enable “
r%me |Sewer|Cer‘ti"'cate Expiry Time |
Description
Severity High e
~ | | SA Server PKI Certificate Expiration ~ | SERWER_CERT w
v || 2400 For |0 | Minutes
w2400 For 1 < Minutes

Time Zone: UTC {GMT+00:00)

Click on + to add suppression to rule

Cancel Save

Edit a Policy

1. Goto ADMIN > Health & Wellness.
2. Click the Policies tab.
The Policies view is displayed.
3. Select a policy (for example, Concentrator Policy Status) under a host or service.
The Policy Detail is displayed.
4. Click 4,
The policy name (for example, Admin Server Monitoring Policy) and policy detail
panel become editable.
15 Monitoring Health and Wellness of NetWitness Suite



System Maintenance Guide

RSA RESPOND  INVESTIGATE MONITOR CONFIGURE ADMIN @zdmm- @

Health & Wellness

Aarms  Monitoring VIS System Stats Browser  Event Source Monitoring  Settings

- Admi o f ok :
Policies Admin Server: Admin Server Monitoring Policy m
+ F1Bxy Rules and sup ules of Out-ofithe-box policies cannot be directly modiied. Duplicace the poliy if you wish t0 50 modify them
[ Enable Last Modified: 2017-02:20 12:00:00 AM
45 Admin Server 0
Admin Server Monitoring Policy Services
» [ Archiver ] Cheose the hosts, services, and groups that your health policy applies to
(1] +
Neme ~ Groy Type
P i
A 0 G
(]
1]
Rules
0 Define the conditions under which you ger an alarm for the Netiicness Suite health problems (definition includes severity, statistic the alarm applies to, threshold, and thresheld &t which the alarm clears).
After you define the alarm rule, enable or he alsrn
(1]
0
0 Enable  Name ~ Severity Category Statstic Threshold
Admin Servar in Criti..  Critica Overall Pr 'm = ERROR for 2 MINUTE!
0
Hig Qverall Processi
» [ Log Collector (1]
Criica Serv
»[Loz [ T

NETWITNESS SUITE

6.1.abc6c92

5. Make the required changes and click Save in the Policy Detail panel. You can:
o Edit the Policy name.
o Enable or disable the policy.
o Add or delete hosts and services in the policy.
o Add, delete or modify rules in the policy.
o Add/Edit/Delete suppressions in the policy.

o Add/Edit/Delete notifications in the policy.

Note: Save applies the policy rules based on the selection of enable/disable. It also resets the
rule condition timers for changed rules, and the entire Policy.

Duplicate a Policy

1. Goto ADMIN > Health & Wellness.
2. Click the Policies tab.

3. Select a policy (for example, Concentrator Policy Status) under a host or service.

4. Click & .NetWitness Suite copies the policy and lists it with (1) appended to the original
policy's name.

Monitoring Health and Wellness of NetWitness Suite 16
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S.

RSA' RESPOND  INVESTIGATE MONITOR CONFIGURE ADMIN

Health & We

Alarms  Monitoring [l System Stats Browser  Event Source Monitoring  Settings
Policies Decoder: Decoder Monitoring Policy [ soe |
+ Z | B b4 Rules and suppressicn schedules of Out-of-the-box policies cannot be directly modified, Duplicate the policy if you wish to so modify them
¥ Enable Last Modified: 2017-01-20 12:00:00 AM
» [JAdmin Se 0
¥ CJhchiver 0 Serices
Do 0 Choose the hasts,senvices, and groups that your heakth poicy applies to
» [JConcentras 0 +
» (3 Config Server ol ! Name ~ Group Tipe
Al up
¥ (Y Comenthub Senve 0
45 Decor 0
arm for th ¢ heakth problems (definition includ shold, and threshold at which the alarm clears).
0
0
Categor Statistic Threshold
) 0 gory
Capture Capture Status Hlarm for 0 MINUTES
b inves (]
Lapture
» [JLog Colle 0 s
stabas
0" -

Click [ and rename the Policy [for example, rename Decoder Monitoring Policy(1) to

New Concentrator Policy Status.

Note: A duplicated policy is disabled by default and the host and service assignments
are not duplicated. Assign any relevant hosts and services to the duplicated

policy before you use it to monitor health and wellness of the NetWitness Suite
infrastructure.

Assign Services or Groups

To assign hosts or services to a policy:

1.

2.

Go to ADMIN > Health & Wellness.

Click the Policies tab.

The Policies view is displayed.

Select a policy (for example, First Policy) under a host or service.
The Policy Detail is displayed.

Click ¥ in the Services and Groups list toolbar.

Choose one of the following actions:

17
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o For Hosts, select Groups or Hosts from the selection menu.
o For Services, select Groups or Services from the selection menu.

6. Depending on whether you are assigning services or groups, perform one of the following

actions:
o Groups, the Groups dialog is displayed from which you can select predefined groups of

hosts or services.

Add Groups
Groups Services
Name Filter *
& Name Host Type
Concentrator MWAPPLIANCEZ2655 Concentrator

Cancel Select

Monitoring Health and Wellness of NetWitness Suite 18
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7.

o Services, the Services dialog is displayed from which you can select individual services.

Add Service
Groups Services
Mame Filter *
= Name Host Type
[l Concentrator MWAPPLIANCEZ22655 Concentrator

Cancel Select

Select the checkbox next to the groups or services you want to assign to the policy, click

Select in the dialog, and click Save in the Policy Detail panel.

Note: Services are filtered for selection based on the type of policies. For example, you can
only select concentrator services for a concentrator type policy.

Remove Services or Groups

To remove a host or service from a policy:

1.
2.

Go to ADMIN > Health & Wellness.
Click Policies tab.

The Policies view is displayed.

Select a policy under a service.

The Policy Detail is displayed.

Select a host or service.

Click = .

The host or service is removed from the policy.

19
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Add or Edit a Rule

To add a rule to a policy:

1.
2.

Go to ADMIN > Health & Wellness.

Click the Policies tab.

The Policies view is displayed.

Select a policy (for example, Checkpoint) under a host or service.
The Policy Detail is displayed.

Depending on whether you are adding an existing rule or adding a rule, do the following:
« Toadd: click ¥ in the Rules list toolbar.

« To edit: select a rule from the Rules list and click L.

Complete the dialog to define or update the rule.

Add the Description field as shown in the following example.

Add Rule

Enable “ -
Name Check Point
Description Trigger alarm when Check Point Log Collection stops
severity Medium e
Checkpoint Collection v | Collection State ~
= ~ | stopped For |1 | Minutes
= v~ started For 1 < Minutes

Time Zone: UTC (GMT+00:00)

™| pays Time Range
™ Sun Mon Tue Wed Thur Fri Sat 00:00 To 00:15 .
Click OK.

The rule is added (or updated) to the policy.

Hide or Show Rule Conditions Columns

To hide or show rule conditions columns in the Rules panel:

Monitoring Health and Wellness of NetWitness Suite 20
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1. Goto ADMIN > Health & Wellness.
2. Click Policies tab.
The Policies view is displayed.
3. Select a policy under a service.
The Policy Detail is displayed.
4. Go to the Rules panel.

Rules

Define the conditions under which you want to trigger an alarm for the NetWitness Suite health problems (definition includes severity, statistic the alarm
applies to, threshold, and threshold at which the alarm clears). After you define the alarm rule, enable or disable the alarm.

[l Enable Name ~ Severity Category Statistic Threshold

O [ ] Concentrator.,  Medium Concentrator Queries Pending Alarm >=5 for 10 MINUTES

O [ ] Concentrator...  Medium Devices Seszions Behind Alarm >= 100000 for 30 MINUTES
O [ ] Concentrator..  High Devices Sessions Behind Alarm == 1000000 for 30 MINUTES
O ® Concentrator...  Critical Devices Seszions Behind Alarm >= 50000000 for 30 MINUTES
O [ ] Concentrator...  Critical Concentrator Status Alarm != 'started’ for 0 MINUTES

O ® Concentrator... Critical Datzhaze Status Alarm !="opened’ for 0 MINUTES
O [ ] Concentrator...  High Concentrator Rule Error Count Alarm = 0 for 0 MINUTES

1 - Pl ok, Caisieal Pl o, Bflcso Dose [ =1 AL =N £ D RAIKIITOC

5. Click v to the right of Category , select Columns, and uncheck the Static and Threshold
rule conditions.

You can check or uncheck any Rules column to show or hide it.
The Rules panel displays without the rule conditions.
Delete a Rule

To remove a host or service from a policy:

1. Goto ADMIN > Health & Wellness.

2. Click the Policies tab.

The Policies view is displayed.

3. Select a policy under a service.

The Policy Detail is displayed.
4. Select a rule from the Rules list (for example, Checkpoint).

5. Click = .

The rule is removed from the policy.

21 Monitoring Health and Wellness of NetWitness Suite
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Suppress a Rule

1. Click the Policies tab.

The Policies view is displayed.

2. Select a policy under a service.
The Policy Detail is displayed. You can specify rule suppressions time ranges when you

initially add it or you can edit the rule and specify suppression time ranges.
3. Add or edit a rule.

4. In the Rules Suppression panel of the Add or Edit Rule dialog, specify the days and time

ranges during which you want the rule suppressed.

Suppress a Policy

1. Add or edit a policy.

The Policies view is displayed.
2. In the Policy Suppression panel:

a. Select a time zone from the Time Zone drop-down list.

This time zone applies to the entire policy (both policy suppression and rule suppression).

b. Click ¥ in the toolbar.

c. Specify the days and time ranges during which you want the policy suppressed.

Add an Email Notification

To add an email notification to a policy:

1. Add or edit a policy.

The Policies view is displayed.
2. In the Notification panel:

a. Click ¥ in the toolbar.
A blank EMAIL notification row is displayed.

b. Select the email:

o Notification types in the Recipient column (see Configure Notification Outputs in the
NetWitness Suite System Configuration Guide for the source of the values in this drop-

down list).

Monitoring Health and Wellness of NetWitness Suite 22
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o Notification server in the Notification Server column (see Configure Notification
Servers in the NetWitness Suite System Configuration Guide for the source of the

values in this drop-down list).

o Template server in the Template column (see Configure Notification Templates in
the NetWitness Suite System Configuration Guidefor the source of the values in this
drop-down list).

Note: Refer to Include the Default Email Subject Line if you want to
include the default Email subject line from the Health & Wellness template in
your Health & Wellness Email notifications for specified recipients.

Delete an Email Notification

To add an email notification to a policy:

1. Add or edit a policy.

The Policies view is displayed.
2. In the Notification panel:
a. Select an email notification.

b. Click = .

The notification is removed.

Include the Default Email Subject Line

The emails generated by the notifications you set up for policies do not include the subject line
from the Health & Wellness Default Email Notification templates. Y ou need to specify the
subject line in the do not include subject lines. This procedure shows you how to insert a subject
line into the templates.

For related reference topics, see Policies View and NetWitness Suite Out-of-the-Box Policies.

To include the subject line from a Health & Wellness email template in your email notification:
1. Goto ADMIN > System.
2. In the options panel, select Global Notifications.

3. Select a Health & Wellness Email Template (for example, Health & Wellness Default
SMTP Template).

23 Monitoring Health and Wellness of NetWitness Suite
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RSA' RESPOND

INVESTIGATE

MONITOR CONFIGURE  ADMIN

System

L Global Notifications
Updates
Output Servers | Templates
Licensing
X
Emai + l @

[ Global Notifications L Name ~ Template Type Description Actions.
Legacy Notifications Default Audit CEF Template Audit Logging Default Audit CEF Template fed
System Logging Default Audit Human-Readable Format Audit Logging Default Audit Human-Readable Format fed

lobal Auditin - . : -

Global Auditing Defauts SMTP Template Event Swream Analysis Default SMTP Template %
Jobs

Default SNMP Template Event Stream Analysis Default SNMP Template fed
Live Services
URL Integration Default Script Template Event Stream Analysis Marker template for Seript norif fol

€8

Context Menu Actions Defaul: Syslog Template Event Stream Analysis Default Syslog Template fol
Investigation £5M Defaul Email Template Event Source Monitaring ESM Default Email Template ]
ESA -~

ESM Default SNMP Template Event Source Monitoring ESM Default SNMP Templace &
ESA Analytics
Whois [0 ESM Defauk Syslog Template Event Source Monitoring ESM Default Syslog Template &
HTTP Proxy Settings Health & Wellness Defaul: SMTP Template Health Alarms Health & Wellness Defaul SMTP Template F o SIS

»
NTP Settings
Page 1 oft | | C Pagesze 25 Displaying 1- 12 of 12 templates

NETWI

11.0.00-

The Define Template dialog is displayed.

4. Click 3, then in

the Template ficld, copy the Subject Line (Highlight the subject line and

press Ctrl-C) into the buffer.

Define Template

MName *
Template Type

Description

Template *

Health & Wellness Default SMTP Template
Health Alarms

Health & Wellness Default SMTP Template

#f RECOMMEND: Use this line from the template as the Email Subject line
when defining Motification Type
MW Health <#if state == "ACTIVE"=>${severity?lower_case?cap_first}

everity<#else>${state?lower_case?cap_first}</#if> Alarm:
${ruleName!"Unknown Rule Name"} on ${hostName!"Unknown Host Name'
_—-

<head=

<meta http-equiv="Content-Type" content="text/html; charset=UTF-8">
</head>
<body bgcolor="#eeseee" leftmargin="0" topmargin="0" marginwidth="0"
marginheight="0">
=table border="0" cellpadding="0" cellspacing="0" height="100%"
width="100%" id="bodyTable">

Cancel

Monitoring Health and Wellness of NetWitness Suite
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5. Click Cancel to close the Template.

6. Click the Output tab and select a notification (for example Health & Wellness).

7. Click 4.
The Define Email Notification dialog is displayed.

8. Replace the value in Subject field text box with the subject line that you have in the buffer
(highlight the existing text and press Ctl-V).

Define Email Notification

Enable U
H&W Email notification

To Email Addresses * pratik.shah@rsa.com,scott. marcus@emc.com

Subject Template Type  Health & Wellness default email subject

MW Health <#if state == "ACTIVE"=${severity?lower_case?
cap_first} Severity<#else=%{state?lower_case?cap_first}</#if>
Alarm: ${ruleName!"Unknown Rule Name"} on
${hostName!"Unknown Host Name"}

Cancel

9. Click Save.

Monitor System Statistics

The System Stats Browser filters statistics by the selected host, component running on the host,
statistical category, individual statistic, or any combination of host, component, category, and
statistic. You can also choose the order in which to display this information.

To access the System Stats browser:

1. Goto ADMIN > Health & Wellness.
The Health & Wellness view is displayed with the Alarms tab open.

2. Click the System Stats Browser tab.
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The System Stats Browser tab is displayed.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE  ADMIN @admin- (:\

Health & Wellness

Monitoring  Policies ESEENNEIGEVIEIE Event Source Monitoring  Settings
Host Component Category Statistic Order By

Any v LY Clear

ding ()Descending

Any v Any v

Regex Regex

Host Component Category Statistic Subitem Value

Historical Graph

nwappliance13731 Admin Server Health Checks Configuration.Server-Connection

spelad els

Configura

Process.Modules.M

Securiy.PkiCe

11.000

Filter System Statistics

You can filter the System Statistics in one of the following ways to monitor:

o Statistics collected for a particular host

Statistics collected for a particular component

Statistics collected of a particular type or that belongs to a certain category

« Statistics listed in an ordered way as per the selection chosen

To filter the list of system statistics:
1. Goto ADMIN > Health & Wellness.
The Health & Wellness view is displayed with the Alarms tab open.

2. Click System Stats Browser.
The System Stats Browser tab is displayed.
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RSA| RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Iness

Monitoring ~ Policies  INEEUNEICILEIE Event Source Monitoring

Host Component Category Statistic Order By
Any v Any v

v BN Clear

nding ODescending

Regex CRegex
Host Companent Category Statistic Subitem Value Last Update Historical Graph

nwappliance13731 Admin Server Health Checks Canfiguration.Server-Connection

sielad wels

nwappliance13731 Admin Server

nwapplianc Admin Server

Admin Server
Admin Server
Admin Server
Admin Server

Admin Server

Admin

Admin Server

nwapplianc Admin Server

nwappliance13731 Admin Server

Admin Server CPU Urilization

nwappliance13731 Admin Server Maximum Memory

nwappliance13731 Admin Server Memory Utilization v

| Page 1 of2d [ Y NIC tems 1-50 of 1160

11.000-

Filter the list of System Statistics in one of the following ways:

o To view System Stats of a particular host, select the host in the Host drop-down list.
The System Stats for the selected host is displayed.

o To view System Stats of a particular component, select the component in the Component
drop-down list.
The System Stats for the selected component is displayed.

« To view System Stats of a particular category, type the category name in the Category
field.
Select Regex to enable Regex filter. It performs a regular expression search against text
and lists out the specified category. If Regex is not selected it supports globbing pattern
matching.
The System Stats for the selected category is displayed.

o To order the list of statistics in a preferred order you can set the order in the OrderBy

column

« To view a particular statistic across hosts, type the statistic name in the Statistic field.
Select Regex to enable Regex filter. It performs a regular expression search against text
and lists out the specified category. If Regex is not selected it supports globbing pattern
matching.

The System Stats for the selected statistics is displayed.

The following figure shows the System Stats Browser filtered by the
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NWAPPLIANCE10604 host listed in descending statistical category order.

(l Event Source Monitoring  Settings

Host Component Subitem value Last Update Historical Graph

IEES

4. To view the details for an individual statistic:

a. Select a row to select a statistic.

b. Click
The Stat Details is displayed.
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Stat Details

Host 14e55322-12ba-42f2-2376-8022ebed 2003
Hostname MWAPPLIAMCE 10604
Component ID appliance

Component Host

Marme Mounted Filesystem Disk Usage
Subitem fdevishm

Path

Plugin appliance_df

Plugin Instance dev_shm

Type fs_usage

Type Instance

Description Disk usage information for mounted filesystem
fdevishm

Category FileSystem

Last Updated Time 2017-07-14 03:11:18 PM

value 15.71 5B size, 12.00 KB used, 15.71 GB available

Raw Value 1.686943792E10 bytes size, 12288.0 bytes used,

1.6869445632E10 bytes available

14e55322-12ba-4af2-a376-
20aZebeadso3/appliance_df-dev_shmifs_usage

Graph Data Key

Stat Key 14e55a22-12ba-4af2-3376-
20a2ebed9993/appliance_df-dev_shmifs_usage

stat_collector_version 11.0.0.0

Filesy=tem tmofs b

For details on various parameters in the ADMIN > Health & Wellness > System Stats
Browser view, see System Stats Browser View

View Historical Graph of System Statistics

The historical graph of the collected system stats gives you information about the variation of the
stats over a time frame selected.

To view a historical graph:

1. Goto ADMIN > Health & Wellness.

The Health & Wellness view is displayed with the Alarms tab open.
2. Click the System Stats Browser tab.
3. Inthe System Stats Browser tab, specify the filter criteria to display the statistics you want.

4. In the Historical Graph column, select i

The Historical graph for the selected statistic is displayed.
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The figure below gives an example of the historical graph for Memory Utilization statistic
for a host.

Historical Graph

Host: Memory Utilization Time Frame Current Day v
Zoom 1h 6h 12h 14 Al From | Jul 9, 2017 To | Jul 10, 2017
15.5
18
g
£
185 ®
18
17.5
21:00 10, Jul 03:00 06:00 0%:00 12:00 15:00 18:00
10. Jul 06:00 _——17.00 T8:00
{11} »
average
Click and drag in the plot area to zoom in

The graphical view is customized to display the statistics collected for the current day and
the values are zoomed in for an interval of an hour (10.15 - 11.15 hrs). Hover over the graph
to view the details at a particular instant. For example, in the figure it displays the memory
utilization at 11.00 hrs.

Note: You can customize the graph view by selecting the Time Frame and Date range. You
can zoom in using the zoom in value, time window, or by just a click and a drag in the plot
area. For details on the parameters to customize and zoom in functions, see Historical Graph for
System Stats. Any break or gap in chart line indicates that the service or host was down during
that time.

Monitor Service Statistics

NetWitness Suite provides a way to monitor the status and operations of a service. The Service
Stats view displays key statistics, service system information, and host system information for a
device. In addition more than 80 statistics are available for viewing as gauges, and in timeline
charts. Only statistics for session size, sessions, and packets are viewable in historical timeline
charts.

Although different statistics are available for different types of services, certain elements are
common for any Core device.

To monitor service statistics in NetWitness Suite:
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1. Goto ADMIN > Services.

The Services view is displayed.

2. Select a service, and select View > Stats in the Actions column.

RSA| RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Services

. Change Service | E Decoder | Stats ©
Decoder
Key Stats Service System Info Host System Info Physical Drives
0 MbPS 0% 0% o
0 MbPS 1,005.4 MB 1,005.4 MB =
31.4GB 31.4GB sda
22 Packets 126.1 M8 226 MB
0 Packets (0% loss) : 31.4GB 31.4GB
0 Packets 1 hour and 50 minutes
2017-Jun-12 07:54:45 4 hours and 33 minutes

Ready

2017-Jun-12 07:54:52 2017410 13:13:48 Ready

2017-Jul-10 15:04:35 20174ul-10 10:30:42

Gauges - Page 1 of 1

Memory Process i cpu X Memory Process Max

| NETWITNESS SUITE 11.0.0.0-

3. To customize the view: Collapse or expand charts, for example expand the Chart Stats Tray
to see available charts. Drag a section up or down to change the sequence. For example,

drag the Gauges section to the top so that it is above the Summary Stats section.

Add Statistics to a Gauge or Chart

In the Services Stats view, you can customize the monitored statistics for individual services.
The Chart Stats Tray lists all available statistics for the service. The number of statistics varies
according to the type of service being monitored. Any statistic in the Chart Stats Tray can be
displayed in a gauge or a timeline chart. Only statistics for session size, sessions, and packets
are viewable in historical timeline charts.

Create a Gauge for a Statistic

To create a gauge for a statistic in the Services Stats view:

1. Goto ADMIN > Services.
The Admin Services View is displayed.
2. Select a service and select View > Stats in the Actions column.

The Chart Stats Tray is displayed on the right side.

3. If'the tray is collapsed, click to view the list of available statistics.

4. From the Chart Stats Tray, click on any statistic and drag it into the Gauges section.
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A gauge is created for the statistic. If there is no space for the gauge, a new page is created
on the Gauges section and the gauge is added to the new page. In the example, the Active
CPU Time chart was added to the Gauges section by dragging it from the Chart Stats Tray.

Gauges - Page 1 of 1

H X CPU X Memory Process Max 10D Active CPU Time X
Name 4 Value .
Dis...  Memory Process Max

Path  /sys/stats/memory.process.max

Sta..  Memory.process.max

0%

Active CPU
Time

Process

Create a Timeline Chart for a Statistic

To create a timeline for a statistic:

From the Chart Stats Tray, click on a statistic and drag it into the Timeline Charts or the
Historical Timeline Charts section.

A timeline chart is created for the statistic. If there is no space for the chart, a new page is
created on the Timeline Chart section and the chart is added to the new page. In the example,
the Assembler Packet Pages chart was added to the Timeline Charts section by dragging it from
the Chart Stats Tray.

Timeline Charts - Page 1 of 1 At

Memory Process #X CPU &X

D O=aah

T I I T I I I T T I
11:06 am 11:08 am 11:10 am 11:11am 11:13am 11:08 am 11:08 am 11:10 am 11:11am 11:13 am
X Assembler Packet Pages X

L=

I T I I
11:08 am 11:10 am 11:11am 11:13am

Search for a Statistic in the Chart Stats Tray

To search for a statistic, type a search term; for example, session, in the Search field
and press RETURN. Statistics that match are displayed with the matching word highlighted.

Monitoring Health and Wellness of NetWitness Suite 32



System Maintenance Guide

Chart Stats Tray

Search |session| X

Stats

Assembler Sessions
Stat Mame:3zsembler.sessions
Path:/decoder/stars/assembler.zessions

Session Bytes
Stat Name:session.bytes
Path:'database/stats/session. bytes

Session Bytes Last Hour
Stat Name:session.bytes.|last.hour
Path:/'database/stats/session. bytes.last. hour

Session Completion Queue
Stat Name:pool.session.complets
Path'decoder/parsers/stats/pocl.session.complete

Session Correlation Queue
Stat Mame:pool.session.correlats
Path:/decoder/stats/pool.session.correlate

Session Decrement Queue
Stat Name:pool.session.decrement
Path:'decoder/stats/pool.session.decrement

Session Export Cache Files
Stat Name:=xport.session.cache.files
Path:/decoder/stats/export.session.cache.files

| Page 1 of2 | }» » | C

-

Stats 1-12 of 24

Edit Properties of Statistics Gauges

The Gauges section of the Service Stats view presents statistics in the form of an analog gauge.
The properties of each individual gauge are editable; all gauges have an editable title and some

have additional editable properties.

Edit Properties of a Gauge

1. Goto ADMIN > Services

The Admin Services view is displayed.

2. Select a service and select View > Stats in the Actions column.

The Service Stats view includes the Gauges section.

3. Go to the gauge for which you want to edit properties (for example, Memory Process).
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Memory Process Max

aGE

7.7GB

18.0GB 44 0GB

31.4GB

0.0 Memory Process 82.8GE
Max

50.3GB

553.6GB

4. Click the Properties icon ('ﬁ}) to display the parameter names and values.

5. To highlight the value of the Display Name field, double-click on the value; for

example, Memory Process.

editable in the gauge.

Note: Clicking the other two values does nothing because the properties are not

5. Type a new value for the Display Name and click the Properties icon (ﬁ} ).

The new title replaces Memory Process.

Add Stats to the Gauges Section

You can add more gauges by dragging a statistic from the Chart Stats Tray into the Gauges

section.

1. To expand the Chart Stats Tray, click <l .

2. Scroll down and select a statistic, for example, Session Rate (maximum).

3. Drag the statistic to the Gauges section.

The new gauge is displayed in the Gauges section.

Edit Properties of Timeline Charts

Timeline charts display statistics in a running timeline. The Service Stats view includes two
types of timelines: current time and historical. You can drag any statistic available in the Chart
Stats Tray to the Timeline Charts section. Only statistics for session size, sessions, and packets
are viewable in historical timeline charts. The properties of an individual timeline chart are
editable; all timeline charts have an editable title and some have additional editable properties.

To access the charts:

Monitoring Health and Wellness of NetWitness Suite
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1.

2.

Go to ADMIN > Services.

Select a service and click Stats.

The Services Stats view is displayed. The charts are in this view.

Edit Properties of a Timeline

To edit properties of a timeline chart:

L.

Go to the timeline chart for which you want to edit properties (for example, Memory
Process).

Timeline Charts - Page 1 of 1 A—+
Memory Process &BX CPU &BX
1.18 20—
838 2M 1.5 =
EEE.SI’:‘% 1.0
I7AM 05—
oo T T T T oo T T 1 1 1
11:06 am 11:08 am 11:10 am 11:11am 11:13 am 11:06 am 11:08 am 11:10 am 11:11am 11:13 am
Memory Process Max X Assembler Packet Pages X
67.58 T 72.0
50.68 1 t 54.0
= S -
03 o0

Click the Properties icon (ﬁ} ) to display the parameter names and values.

Double-click on a value (for example, the Display Name field) to make the value editable.

Note: Clicking the other two values does nothing because the properties are not editable in
the chart.

Type a new value and click the Properties icon ({E} ).

The timeline chart is displayed with new values.

Edit Properties of a Historical Timeline

To edit properties of a historical timeline chart:

1.

Go to Historical Timeline Charts.

Click the Properties icon (ﬁ:" ) to display the parameter names and values.

Click on a value (for example, 01/27/2015 for the Begin Date field) to make the value
editable.

Type a new value.

Edit the End Date and Display Name if required.
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6. Click the Properties icon (ﬁ} ).

The historical timeline is displayed with new values.

Note: To return the properties of the historical timeline chart back to the default so that the
values dynamically update, remove the Begin Date and the End Date, place your cursor in the
Begin Date field, and refresh your browser.

Add Stats to Timeline Charts

You can add timeline charts by dragging a statistic from the Chart Stats Tray into the Timelines
section.

1. To expand the Chart Stats Tray, click <I .

2. Scroll down and select a statistic; for example, Session Rate (maximum).

3. Drag the statistic to the Timelines Section.

The new timeline is displayed in the Timelines section.

Monitor Hosts and Services

NetWitness Suite provides a way to monitor the status of hosts and services installed. You
can view the current health of all the hosts, services running on the hosts, their CPU usage and
memory consumption and the host details and service details.

To monitor hosts and services in NetWitness Suite:

1. Goto ADMIN > Health & Wellness.
The Health & Wellness view is displayed with the Alarms tab open.

2. Select the Monitoring tab.
A list of all hosts and their associated services that belong to the group All is displayed by
default.

The operational status, CPU usage, and memory usage for each host is displayed.
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RSN RESPOND INVESTIGATE MOMNITOR CONFIGURE ADMIN (T samin @

Hosts Seryices At SouUrces Hezlth & Wellness

Maonitaring Policies System Stans Browser  Event Source Monitoring

Groups Hosts Filte
Kame Count
Stopped Services Stopped Processing Physical Drive Problems Logical Drive Problems Full Filesystems
8 e 1] 3 0 hosts) 0 hosifs) 0 hosts)
-] APPLIAMCEZ29E Seatus PU: 1.13% Memeny: 5.871 GE/AT.42GB
HESRR StAtUS | Rate Hame SErvice Type cPU Memory Usage Uptirie
L] 0 HWABPUANCEZ296 - Broke HEE 0.2% 2332 ME 2 days 21 nowrs 45 minutes 51 seconds
. - " (IR zeconds
Rea o (E22! 21 Werkibensh .25 aLon
B APPLIAMCESZS0 St Memeny 22
sanvite HEARN SAtuS | Rate Harme SErCE Type =0
Ready L] & WWABBLIANCES290 - Brokg Brougr 0.3%
a3 Raparing Engire 0.2%
Rea el
Rea
Ready S0 - Adem
Read CEX50 a K
L]
Page (1 | of1 | Displaying1-20f 2

Click E to the left of a host (& is visible if there are services installed on a host)

3. A list of services installed on the selected host is displayed.
The name, operating status, CPU usage, memory usage, and the time operating for each

service is displayed.

Filter Hosts and Services in the Monitoring View

You can filter hosts and services in the monitoring view in one of the following ways:

o Hosts belonging to a particular group

o Specific host and its associated services

o Hosts whose services are stopped

o Hosts whose services have stopped processing or processing has been turned off
o Hosts that have Physical drive problems

o Hosts that have Logical drive problems

o Hosts that have Full File systems

For the related reference topic, see Monitoring View.

To filter hosts and services:
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1. Goto ADMIN > Health & Wellness.

The Health & Wellness view is displayed with the Alarms tab open by default.
2. Select the Monitoring tab.
3. Filter the hosts and services in one of the following ways:

o To view a list of hosts and their associated services belonging to a particular group, select
the group in the Groups panel.

All hosts and their associated services belonging to the specified group are displayed in
the Hosts panel.

Note: The grouping of hosts is derived from the groups created in the
Administration page. All groups created in the Administration page are displayed here.

For example, if you select the group LC_Group in the Groups panel, a list of all hosts
that are part of the group are displayed.

o To view a list of all services that have stopped processing, click Stopped Processing in
the Hosts panel.

A list of all the hosts that have at least one service with the status as stopped processing
is displayed.

Note: The buttons on the top display the System Statistics for all the hosts configured in
NetWitness Suite and does not change with application of filters on groups.

RSA| RESPOND  INVESTIGATE MONITOR CONFIGURE ADMIN @ agmn® (3

Health & Wellness

Monitoring Policies System Stats Browser  Event Source Monitoring Settings

Groups Hosts Filter
ame Sount Stopped Services Stopped Processing Physical Drive Problems Logical Drive Problems Full Filesystems
San @ 0 5 0 host(s) 0 host(s) 2 host(s)
B NWAPPLIANCE9 Status: CPU: 6.15% Memory: 21.78 GB/31.42 GB
Service Health Status ~ Rate Name Service Type CPU Memory Usage Uptime
Ready [ ] 0 Broker Broker 0.3% 22.18MB 1 day 8 hou
Ready - Reporting Engine Reporting Engine 7.23 153GB 1 day 8 hou
Ready 0 Orchestration Server 0.2% 753.33MB 1 day 8 hou
Ready -~ Security Server Security Server 0.2% 664.82 MB 1 day 8 hou
Ready - Admin Serve Admin Server 0.1% 728.84MB 1 day & hou
Ready - Config Serve Config Server 0.1% 688.21 MB 1 day 8 hou
Ready - vestigate Serv Investigate Server 0.2% 678.88 MB 1 day 8 hou
Ready - Respond Serve Respond Server 0.2% 742.28 MB 1 day 8 hou
X -
| Page 1 | of1 | | C Displaying 1-5 of 5

NETWITNESS SUITE 11.0.0.0-170709005430.1.9127d8d
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Note: In a similar way you can filter the list of hosts and the associated services by choosing
the right filter

- Click Stopped Services to display a list of all stopped services.

- Click Physical Drive Problems to display a list of host with Physical Drive Problems.

- Type the host name in the Filter box to display only the required host and the services
running on the host.

Monitor Host Details

You can view the details of the host, its memory and CPU usage, system information, the
physical drive, logical drive and file system details to further investigate if you encounter some
problem with the host.

To view host details:

1. Goto ADMIN > Health & Wellness.
The Health & Wellness view is displayed with the Alarms tab open.

2. Select the Monitoring tab.
3. Click a host in the Hosts panel.

The Host Details view is displayed as a new page.

RSA RESPOND  INVESTIGATE  MONITOR CONFIGURE  ADMIN @ admin® (3)

Health & Wellness

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings NWAPPLIANCES @

HOST AND SERVICES 1
Host Details
I Host
System Info
Broker
R —— Host NWAPPLIANCES Memory Utilization
i ngir e
cPU 3, Used Memory
r ory
Orchestration Server Running Since 2017-Jul10 09:44:02 Total Memory
Security Server Current Time 2017-Jul-11 16:43:42 Cached Memory
Admin Server Uptime 1 day 6 hours 59 minutes 40 seconds Swap Utilization
System Info Used Swap
Config Server SR Linux 3.10.0-514.26.2.¢17.x86_64 x86_64 Total Swap
Investigate Server
Respond Server Physical Drive || Logical Drive | File System Adapter Message Bus
State Enclosure Slot Failure Count Raw Size Inquiry Data

NETWITNESS SU 11.0.0.0-170709005430.1.9127d8d

Monitor Service Details

You can view the details of a service, its memory and CPU usage, system information, and
various details depending on the service selected.
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To view service details:

1. Goto ADMIN > Health & Wellness.

The Health & Wellness view is displayed with the Alarms tab open.

2. Select the Monitoring tab.
3. Click £ for a host in the Hosts panel.

A list of services running on the host is displayed.
4. Click on any service.

The service details view is displayed as a new page. The Archiver, Broker, Concentrator,
and Decoder service details views have the Service and Details panels.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN :ﬁ;ﬁidmln 2

Health & Wellness

Alarms Monitoring Policies  System Stats Browser  Event Source Monitoring ~ Settings ~ NWAPPLIANCE10604 - NUENIZNENNaPFIL-]

HOST AND SERVICES n o
Concentrator Details

Host
Service

I Concentrator

cpPu 05% Used Memory
Running Since 2017-Jul-10 10:30:32 Max Process Memaory
Build Date 2017-Jul-09 07:19:42 Version Information 1.
Details
Aggregation State started Time Begin
Meta Rate 0 Time End
Meta Rate Max 97222
Session Rate 0
Session Rate Max 1943

‘ NETWITNESS SU 11.0.0.0-170709005430.1.9127d8d

The Event Stream Analysis (ESA) service details view has the Serviceand Details panels,
plus the Monitor and JVM tabs that show additional statistics.
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RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Health & Welln

Alarms Monitoring Policies = System Stats Browser = Event Source Monitoring  Settings

ESA Details
Host
Service
I Event Stream Analysis
CcPU 0.2%
Contexthub Server
Running Since
Entity Behavior Analytics

Build Date

Details

Rules

Monitor VM
Deployed Rule Memaory Utilization
Name

dynamicAlert

dynamicAlert: meta_value_length

ngine_LOCAL_596367dbedblef1 bdft

g
o
a
On
Q

NWAPPLIANCE10604 @

Used Memory

Max Process Memory

Version Information

Event Stream Engine Average Estimated Memory (last hr)
Local ESA (Default)

Local ESA I

Local E
Local ESA(

Local ESA (Default)

11.0.0.0-17070900:

The Malware Analysis service details view has the Service panel plus the Rules, Events,

and JVM tabs that show additional statistics.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Health & Wellness

Policies System Stats Browser  Event Source Monitoring

Settings NWAPPLIANCE10604 -

RZGENEU [ PP CCC NWAPPLIANCE2943 @ | >

Malware Details
Malware Deta
Service

cPU

Running Since

Build Date

m

VM

Number Of Events For Past 24 Hours
Number Of Files For Past 24 Hours
Number Of Events For Past 7 Days
Number Of Files For Past 7 Days
Number Of Events For Past Month
Number Of Files For Past Month
Number Of Events For Past 3 Months

Number Of Files For Past 2 Months

| NETWITN

Used Memory
Max Process Memory

Version Information

Average Processing Time
Events In Queue

Events Processed

Events Per Second Throughput

Session Time Of Last Event

11.0.0.0-170709005430.1.9127d8d

The Reporting Engine service details view has the Service panel plus the Report and JVM

tabs that show additional statistics.
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RSA RESPOND INVESTIGATE MONITOR CONFIGURE L @:adn’un 5

Services Event Source! Health & Wellness

Alarms Monitoring Policies  System Stats Browser ~ Event Source Monitoring ~ Settings NG RENN @S T

HOST AND SERVICES —n - J—
Reporting Engine Details
Host
Service
Broker
crPu 14.8% Used Memory .53 GB
I Reporting Engine = ’
Running Since 2017-Jul-10 10:04:28 Max Process Memory 31.42GB
Orchestration Server
Build Date Version Information
Security Server
Admin Server Report JVM
Config Server Number Of OAs Failed In Last Hour 0 Number Of Active Requests 0
Investigate Server Number Of Reports Failed In Last Hour 0 Average Time Taken For RE Requests 0 milliseconds
R Number Of Rules Failed In Last Hour 0 Number Of Enabled Alerts 0
Respond Server
Maximum Time Taken For RE Request 215 milliseconds Number Of Alert Execution Failed In Last
el 10 Minutes -
Number Of Requests Completed 2543 inutes
Max Number Of Rows Fetched For 10 Max Rows Fetched For Alerts b
Charts Number Of Requests Failed In Last 10 N
M
Number Of Chart Executions Failed In n=
Last 10 Mins N Number Of Requests Received 2543
Number Of Enabled Charts 15 Number Of Requests Failed 0 £

NETWITNES J 11.0.0.0-1707090054:

Note: Alternatively, you can access the service details page by clicking the services listed in
the options panel in the Host Details view.

Refer to Monitoring View for a detailed description of the Details view for each service.

Monitor Event Sources

The event source monitoring feature of NetWitness Suite provides the following functionalities:

Support for failover

o Provides a consolidated list of event sources and their associated collector and log decoder

devices
o Regex support for rules
o Decommission
« Filtering capabilities
o Historical graph
In addition, you can monitor event sources, check the number of events generated from a source

type and view the historical graph of the events collected. To monitor event sources you have to
configure the event sources so that they generate and send out notifications when required.
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Configure Event Source Monitoring

To monitor event sources you have to configure the event sources so that they generate and send
out notifications when required. For the related reference topic, see Health and Wellness Settings
View - Event Sources.

To configure and enable event monitoring in NetWitness Suite:

I.

2.

3.

Go to ADMIN > Health & Wellness.
Select Settings > Event Source.

The Event Source tab is displayed.

RSA| RESPOND INVESTIGATE MONITOR CONFIGURE  ADMIN

Health & Wellness

Alarms Monitoring Policies

Event Source Archiver Warehouse Connector

Event Source Monitoring

These setting dictate when to generate notifications for event sources that the system is no longer receiving logs from and where t

Regex  Source Type Source Host Time Threshold

Hours. Minutes

NETWITNESS SUITE

Under Event Source Monitoring, click +.
The Add/Edit Source Monitor dialog is displayed.

Define the Source Type, Source Host, and Time Threshold for the source of the event
source that you want to monitor to detect when NetWitness Suite stops receiving logs from
it. If you do not specify a Time Threshold, NetWitness Suite monitors the event source

until you set a threshold.

Note: For Source Type and Source Host, you must specify the values that you
configured for the event source in the Event Sources tab of the Administration >
Services > Log Collector service > View > Config view. You add or modify the the
event sources that you want to monitor. The two parameters that identify an event
source are Source Type and Source Host. You can use globbing (pattern matching
and wildcard characters) to specify the Source Type and Source Host of event sources
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Add/Edit Source Monitor

[ Regex

Source Type *

Source Host *

0 Hours

Time Threshold *
0 Minutes

5. Click OK.
The event source is displayed in the panel.

6. Configure the method of notification, by doing one of the following:
o Select Configure email or distribution list.

The AMIN > System > Email Configuration Panel is displayed so that you can specify to
whom the notifications are sent.

« Select Configure Syslog and SNMP Trap servers.

The Administration > System Auditing Configuration panel is displayed so that you can
configure the Syslog and SNMP Traps to which the notifications are sent.

7. Click Apply.

NetWitness Suite begins sending notifications when it stops receiving events from this event
source after the time threshold has elapsed.

For details on parameters in the Event Source Monitoring settings view, see Event Source
Monitoring View.

Decommission Event Source Monitoring

If a Log Collector service (Local Collector or Remote Collector) for which you set up Event
Source monitoring becomes inoperable, NetWitness Suite continues to notify that you it is not
receiving events from it until you decommission the Collector.

Caution: If you configured a failover Local Collector for a Remote Collector and the Local
Collector fails over to a standby Log Decoder, you must decommission the Local Collector to
stop the notifications.

To decommission event source monitoring for an event source:
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1. Goto ADMIN> Health & Wellness.

2. Select Settings > Event Source.

The Event Source tab is displayed.

3. Under Decommission, click +.

The Decommission dialog displays.

4. Define the Source Type and the Source Host for the source for which you want

to decommission event monitoring notifications.

Decommission

V¥ Regex

Source Type *  apache

Source Host *

Cancel

Filter Event Sources

You can choose a filter to display:

« Events belonging to a particular event source

« Events belonging to particular event source types
o Events collected from a particular log Collector

o Events list arranged in a order based on the Event Source Type, Log Collector, Log Decoder

or Last Event Time.

To filter the list of event sources:

1. Goto ADMIN > Health & Wellness.
2. Select Event Source Monitoring.
3. Filter the list in one of the following ways:

« To view the events generated by a particular event source, type the required event source in

the Event Source field. Select Regex to enable Regex filter and click Apply. It performs a
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regular expression search against text and lists out the specified category. This field also
supports globbing pattern matching.
All events generated by the Event Source specified are displayed.

o To view events collected from a particular Log Collector, select a Log Collector from the
drop-down list and click Apply.
A list of all events being collected from the specified Log Collector from various event

sources is displayed.

Note: Similarly, you can also choose the following filters:

- To view events belonging to an event source type, select the event source type and click
Apply.

- To view events received in a specified time frame, select the required time frame and click
Apply. You can further filter the query results to contain only event sources that logs have
been received from within the selected time or the query results to contain only event sources
that logs have not been received from within the selected time.

For details on various parameters and description, see Event Source Monitoring View.

View Historical Graph of Events Collected for an Event Source

The historical graph of the events collected from an event source gives you information about the
variation of the collection over a time frame selected.

To view a historical graph:
1. Goto ADMIN > Health & Wellness.
The Health & Wellness view is displayed with the Alarms tab open.

2. Click Event Source Monitoring.

The Event Source Monitoring view is displayed.

3. In the Historical Graph column, select i

The Historical graph for the selected event source is displayed.
The figure below gives an example of the historical graph for the event source type

winevent_snare.
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Historical Graph
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average

Click and drag in the plot area tc zoom in
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The graphical view is customized to display the events collected for the current day and the

values are zoomed in for an interval of an hour (09.05 - 105.05 hrs). Hover over the graph to
view the details at a particular instant. For example, in the figure it displays the average rate
of collection at 09.30 hrs.

Note: You can customize the graph view by selecting the Time Frame and Date range. You
can zoom in using the zoom in value, time window, or by just a click and a drag in the plot
area. For details on the parameters to customize and zoom in functions see Health and Wellness

Historical Graphs collected from an event source.
If there is no data displayed on the chart it may be due to one of the following reasons:

- event source is down.
- event source is not processing anything right now.

Monitor Alarms

You can set up alarms and monitor them in the Health and Wellness interface for the hosts and
services in your NetWitness Suite domain. Alarms display in the view as Active when the
Policy-rule-defined statistical thresholds for hosts and services have been crossed. Alarms are
grayed out and change to the Cleared status when the clearing threshold has been crossed.

You set up the parameters for alarms in Manage PoliciesManage Policies For the related reference
topic, see Health and Wellness View - Alarms View.

To monitor the alarms set up in NetWitness Suite:
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1. Goto ADMIN > Health & Wellness.
The Health & Wellness view is displayed with the Alarms tab open by default.

RSA' RESPOND  INVESTIGATE MONITOR CONFIGURE  ADMIN @Iadmm- @]

Health & Wellness

LEILE Monitoring  Policies  System Stats Browser  Event Source Monitoring
Time State Severity  Rule Name Service Hostname IP Address Stat Value %
2017-09-1310:06:40AM  Active @ Critical  Concentrator Meta Race Zero nwappliance28765 1031125472 Concentrator/Mesa Rate (current) 0 3
20170 Active @ Criticsl nwappliance 19848 1031.125.473 Capure/Capture Packet Raze [current) Z
Active [] nwapp! MorkUnitProcessingRate 5
Active [} nw
Active [ ] nw
‘
»
| Page 1 oft | | C M AutoRefresh ftems 1-130f 13

11.0.0.0-170918082456.1.2!

2. Click on the alarm for which you want to display details in the Details Panel.

3. Click (expand) to view the details for the alarm you selected.
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Alarm Details

Rule Mame

nformational Text

191-1037-0007

2017-07-10 10:35:43 AM
ACTIVE

CRITICAL

MNWAPPLIANCEZ22655
Concentrator

Concentrator Monitoring Policy
Concentrator Meta Rate Zero

This Concentrator is not receiving meta from its
upstream services, which is indicative of an
aggregation problem or capture problem on an
upstream service,

Possible Remediation Action:

Pleasze check whether aggregation iz started on
the Concentrator, and whether all upstream
Decoders from which it is aggregating are in a
'‘consuming' state. There should be additional
corresponding alarms if this is not the case.

To check the assresatinon status of this

Monitor Health and Wellness Using SNMP Alerts

You can monitor an NetWitness Server component to proactively alert using Simple Network

Management Protocol (SNMP) based on the thresholds or system failures.

Y ou can monitor the following for NetWitness Suite components:

o CPU utilization that reaches a defined threshold.

o Memory utilization that reaches a defined threshold.

o Disk utilization that reaches a defined threshold.
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SNMP Configuration

The NetWitness Servers can be configured to send out SNMPv3 Threshold Traps and Monitor
Traps. Threshold traps are sent in conjunction with configured node thresholds by the
NetWitness Suite Core applications themselves. Monitor traps are sent by the SNMP daemon
itself for the items indicated in its configuration file. The customer must set up the SNMP
daemon on another service to receive SNMP traps from NetWitness Suite. You can set up
SNMP on NetWitness Suite in the configuration setting for the NetWitness Server. For more
information, see Service Configuration Settings in the NetWitness Suite Host and Services
Getting Started Guide for the specific host.

Thresholds

Thresholds can be set on any service statistics that can accept the setLimit message. You can
retrieve the current thresholds using the getLimit message. To set a limit, you can pass a low
and high threshold value.

When the value of the stat crosses either the low or high threshold, a SNMP trap is triggered
indicating the threshold is crossed. The trap will not be triggered if the value is below the low
and above the high value, but another trap is triggered if it crosses back into the normal range
(above the low and below the high).

Y ou must set the threshold for the service using the Service Explorer view or the REST API.
Following is a sample threshold for monitoring CPU usage (below 10% or above 90%):
/sys/stats/cpu setLimit low=10 high=90

Following is an example of how the threshold is set using REST API:

http://<log decoder>:50102/sys/stats/cpu?msg=setLimit&low=10&high=90

If the CPU usage spikes to 90% or higher, a SNMP trap will be generated:

23435333 2013-Dec-16 11:08:35 Threshold warning path=/sys/stats/cpu
0l1d=77% new=91

Configure SNMPv3 for a Host

1. Goto ADMIN > Services.

The Services view is displayed.
2. Select the service.
3. Inthe Actions column, select View > Explore.

4. In the nodes list, expand the list and select a config folder. For example, logs > config
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5. Set the SNMPv3 configuration.

RSA| RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

%, Change Service | I Concentrator | Explore ©

= Concentrator
B el Concentrator (CONCENTRATOR)
B[] concentrator
B[] connections
B[] database
B[] deviceappliance
B Jindex
B logs 0
[Jcenfig
[Ostats
[Trasks
B Jrest
B ]sdk
B[] services

| NETWITNESS SUITE

(§2) admin

Concentrator (Concentrator)

none

none

noAuthNoPriv

Set the Threshold for a Service

1. Goto ADMIN > Services.

The Services view is displayed.

2. Select the service.

In the Actions column, select View > Explore.

In the nodes list, expand the list and select a stat folder.
Select a stat, for example, cpu, and right-click.

From the drop-down menu, select Properties.

The Properties panel is displayed. The Properties panel has a drop-down list of available
messages for the parameter.

| St

get
getlimit
help
info

setlimit

7. Select setLimit.

8. Specify the low and high values.
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Troubleshooting Health & Wellness

Issues Common to All Hosts and Services

You may see the wrong statistics in the Health & Wellness interface if:

o Some or all the hosts and services are not provisioned and enabled correctly.

o You have a mixed-version deployment (that is, hosts updated to different NetWitness Suite

versions).

o Supporting services are not running.

Issues Identified by Messages in the Interface or Log Files

This section provides troubleshooting information for issues identified by messages NetWitness
Suite displays in the Health & Wellness Interface or includes in the Health & Wellness log files.

User Interface: Cannot connect to System Management Service

System Management Service (SMS) logs:

Caught an exception during connection recovery!
java.io.IOException

at com.rabbitmg.client.impl.AMQChannel.wrap
(AMQChannel.java:106)

at com.rabbitmg.client.impl.AMQChannel.wrap
(AMQChannel.java:102)

at com.rabbitmg.client.impl.AMQConnection.start
(AMQConnection.java:346)

at
com.rabbitmg.client.impl.recovery.RecoveryAwareAMQConnectionFa
ctory.
newConnection (RecoveryAwareAMQConnectionFactory.java:36)

at
com.rabbitmg.client.impl.recovery.AutorecoveringConnection.
recoverConnection (AutorecoveringConnection.java:388)

at
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com.rabbitmg.client.impl.recovery.AutorecoveringConnection.
beginAutomaticRecovery (AutorecoveringConnection.java:360)

at
com.rabbitmg.client.impl.recovery.AutorecoveringConnection.acc
ess$000 (AutorecoveringConnection.java:48)

at
com.rabbitmg.client.impl.recovery.AutorecoveringConnection$l.
shutdownCompleted (AutorecoveringConnection. java:345)

at
com.rabbitmg.client.impl.ShutdownNotifierComponent.notifyListe
ners (ShutdownNotifierComponent.java:75)

at com.rabbitmg.client.impl.AMQConnection$SMainLoop.run
(AMQConnection.java:572)

at java.lang.Thread.run (Thread.java:745)

Caused by: com.rabbitmg.client.ShutdownSignalException:
connection error

at com.rabbitmg.utility.ValueOrException.getValue
(ValueOrException.java:67)

at
com.rabbitmg.utility.BlockingValueOrException.uninterruptibleG
etValue (BlockingValueOrException.java:33)

at
com.rabbitmg.client.impl.AMQChannel$BlockingRpcContinuation.ge
tReply

(AMQChannel.java:343)

at com.rabbitmg.client.impl.AMQConnection.start
(AMQConnection.java:292)

8 more

Caused by: java.net.SocketException: Connection reset

at java.net.SocketInputStream.read
(SocketInputStream.java:189)

at java.net.SocketInputStream.read
(SocketInputStream.java:121)

at java.io.BufferedInputStream.fill

53 Monitoring Health and Wellness of NetWitness Suite




System Maintenance Guide

(BufferedInputStream.java:246)

at java.io.BufferedInputStream.read
(BufferedInputStream.java:265)

at java.io.DataInputStream.readUnsignedByte
(DataInputStream.java:288)

at com.rabbitmg.client.impl.Frame.readFrom(Frame.java:95)
at com.rabbitmg.client.impl.SocketFrameHandler.readFrame
(SocketFrameHandler.java:139)

at com.rabbitmg.client.impl.AMQConnection$SMainLoop.run

(AMQConnection.java:532)

RabbitMQ service not running on the NetWitness Server.

Restart the RabbitMQ, SMS, and NetWitness Suite services using the following
commands.

systemctl restart rabbitmg-server

systemctl restart rsa-sms

systemctl restart jetty

User Interface: Cannot connect to System Management Service

The System Management Service, RabbitMQ, or Mongo service is not running.

Run the following commands on NetWitness Server to make sure all

these services are running.

[root@nwserver ~]# systemctl status rsa-sms

RSA NetWitness SMS :: Server is not running.
[root@nwserver ~]# systemctl start rsa-sms
Starting RSA NetWitness SMS :: Server...
[root@nwserver ~]# systemctl status rsa-sms
RSA NetWitness SMS :: Server is running (5687).
[root@nwserver ~]# systemctl status mongod
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mongod (pid 2779) is running...
systemctl status rabbitmg-server
Status of node nwllocalhost
[{pid, 2501},
{running applications,
[{rabbitmg federation management, "RabbitMQ Federation
Management",

"3.3.4"},

User Interface: Cannot connect to System Management Service

/var/lib/rabbitmg partition usage is 70% or greater.

Contact Customer Care.

User Interface: Host migration failed.

One or more NetWitness Suite services may be in a stopped state.

Make sure that the following services are running then restart the
NetWitness Server:

Archiver, Broker, Concentrator, Decoder, Event Stream Analysis,
Response Server, IPDB Extractor, Log Collector, Log Decoder, Malware
Analysis, Reporting Engine, Warehouse Connector, Workbench.

User Interface: Server Unavailable.
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One or more NetWitness Suite services may be in a stopped state.

Make sure that the following services are running then restart the NetWitness
Server: Archiver, Broker, Concentrator, Decoder, Event Stream Analysis,
Response Server, IPDB Extractor, Log Collector, Log Decoder, Malware

Analysis, Reporting Engine, Warehouse Connector, Workbench.

User Interface: Server Unavailable

System Management Service (SMS), RabbitMQ, or Mongo service is not

running.

Run the following commands on NetWitness Server to make sure all
these services are running.
[root@nwserver ~]# systemctl status rsa-sms
RSA NetWitness SMS :: Server is not running.
[root@nwserver ~]# systemctl start rsa-sms
Starting RSA NetWitness SMS :: Server...
[root@nwserver ~]# systemctl status rsa-sms
RSA NetWitness SMS :: Server is running (5687).
[root@nwserver ~]# systemctl status mongod
mongod (pid 2779) is running...
systemctl status rabbitmg-server
Status of node nw@localhost
[{pid, 2501},
{running applications,
[{rabbitmg federation management, "RabbitMQ Federation
Management",

"3.3.4"},

Make sure /var/lib/rabbitmg partition is less than 75% full

Check NetWitness Server log files
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! (var/lib/netwitness/uax/logs/nw.log) for any errors.

ContextHub stops and does not allow you to add or edit data sources and lists.

The storage is full by 95% or above.

Increase the storage by updating the YML file, located at
/etc/netwitness/contexthub-server/ contexthub-server.yml.
For example, to increase storage from 120 to 150 GB, enter a value (in bytes)

by editing the relevant parameter: rsa.contexthub.data.disk-size:
161061273600

Delete unwanted or unused large list.

Configure the TTL index for the list to automatically delete STIX and TAXI

data and to clean up storage space.

Context Hub runs on a fixed memory and 50% is reserved for cache. When
cache is 100% full, the cache response stops. For all new lookups the response

will be slow.

The cache is full by 50% or above.

By default, Context Hub cleans the cache every 30 minutes. Reduce the cache

expiration time of data sources.

Disable cache for data sources.

Increase the RAM of the CH Java process by editing the -Xmx option
available in the /etc/netwitness/contexthub-server/contexthub-server.conf file.
In JavA OPTS, search for the -Xmx option.

For example, edit the entry as follows:

-Xmx8G

where 8G represents 8GB space. Then restart the ContextHub service.
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Note: The memory is less than the available system memory. Be aware that
there are many other services running on the host.

List Data Source displays an unhealthy stats or status.

Unable to:

« access the data source

o parse or read a CSV file

o schema mismatched CSV

Unable to authenticate when accessing the data source.

Make sure to save the csv file at correct location
i.e/var/lib/netwitness/contexthub-server/data/ and verify the required read

permissions.

Make sure the csv file schema specified while configuring the data source
matches. If not, then either create a new data source with the new schema
or edit the csv file to match the schema. For example, if you configure a
List Data Source with a schema with columnl, column2, and column3.
And next time you update the csv file where the number of column
increase or decrease or the order of the columns are changed. In this case
there is a schema mismatch and the configured list data source will show

“Unhealthy” in Health and Wellness stats.

Make sure the password is correct. To confirm edit the data source, enter
the password and click test connection.

For more information related the above solutions, see Configure Lists as a
Data Source topic in the Context Hub Configuration Guide.

Monitoring Health and Wellness of NetWitness Suite 58



System Maintenance Guide

Issues Not Identified by the User Interface or Logs

This section provides troubleshooting information for issues that are not identified

by messages NetWitness Suite displays in the Health & Wellness Interface or includes in the
Health & Wellness log files. For example, you may see incorrect statistical information in the
Interface.

Incorrect statistics displayed in Health and Wellness interface.

SMS service is not running. SMS service must be running on the NetWitness

Server.

Restart SMS service.

NetWitness Suite does not show the version to which you upgraded until

you restart jettysrv (jeTTy server).

When NetWitness Suite checks a connection, it polls a service every 30
seconds to see if it is active. During that 30 seconds, if the service comes

back up, it will not get the new version.

1. Manually stop the service.
2. Wait until you see that it is it offline.

3. Restart the service.

NetWitness Suite displays the correct version.

NetWitness Server does not display the Service Unavailable page.

After you upgrade to NetWitness Suite version 10.5, JDK 1.8 is not default
version and this causes the jettysrv (jeTTy server) to fail to start. Without
the jeTTy server, the NetWitness Suite server cannot display the Service

Unavailable page.

Restart jettysrv.
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The SMS service is stopped and the following error is displayed in the log

Problem
file: java.lang.OutOfMemoryError: Java heap space
You can use the following solution to increase the memory according to your
needs.
1. Open /opt/rsa/sms/conf/wrapper.conf
ZP root@NWAPPLIANCE3290
Solution

2. Replace wrapper.java.additional.l=-Xmx8192m with:
wrapper.java.additional.l=-Xmx16g

3. Restart the SMS service:

systemctl start rsa-sms
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Managing NetWitness Suite Updates

RSA issues NetWitness Suite software version updates on a regular basis as it strives to
continually improve the product. A software version update consists of a release, service pack,
or patch (including security patch) and ancillary software on which the release, service pack, or
patch depends. User guides are provided for each software version update release, which
include detailed steps for installing the update. It is important that you download the update guide
for the release from RSA Link (https://community.rsa.com/community/products/netwitness) and
follow the steps described there. Additional information is available in the "Update Existing
Host to New Version" topic in the Hosts and Services Getting Started Guide and in System
Updates Panel - Settings Tab.
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Displaying System and Service Logs

NetWitness Suite provides views into system logs and service logs. When you view service logs,
you can also select messages for the service or host.

View System Logs

1. Goto ADMIN > System.

2. In the options panel, select System Logging.
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Display Service Logs
To display NetWitness Suite service logs:
1. Goto ADMIN > Services.

2. Inthe Services grid, select a service.
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3. Inthe Actions column, select View > Logs.

RSA' RESPOND  INVESTIGATE MONITOR CONFIGURE ADMIN @:Iadmm ':I

4 Change Service | I nwappliance13731-Broker |  Logs ©

System Logging
System Logging
Realtime | Historical
v Keywords Broker v | Search

Timestamp Level  Message

NETWITNESS SUITE 11.0.0.0-17091808

Filter Log Entries

To filter the results shown in the Realtime tab:

1. (Optional) For system and service logs, select a Log Level and a Keyword, or both. System
logs have seven log levels. Service logs have only six log levels because they do not include
the TRACE level. The default is ALL log entries.

2. (Optional) For service logs, select the Service: host or service.
3. Click Filter.

The view is refreshed with the most recent 10 entries matching your filter. As new matching
log entries become available, the view is updated to show those entries.

Show Details of a Log Entry

Each row of the Realtime tab Log grid provides the summary information of a log entry. To view
complete details:
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1. Double-click a log entry.
The Log Message dialog, which contains the Timestamp, Logger Name, Thread, Level and

Message, is displayed.

Log Mes=sage

Timestamp 201 7-0e-22T07:47:12.000
Logeer Mame Engine

Thread

Lewel ALIDIT

Mezzage User escalsteduser (session 343, 10.37.125.240:35328) has logged
out

2. After viewing, click Close.

Access Reporting Engine Log File

All Log Files

The Reporting Engine stores the following logs in the rsasoc/rsa/soc/reporting-engine/log
directory:

o Current logs in the reporting-engine.log file.
o Backup copies of previous logs in the reporting-engine.log.* file.
o All UNIX script logs in the files that have the following syntax: reporting-engine.sh_

timestamp.log (for example, reporting-engine.sh _20120921.log).

The Reporting Engine rarely writes command line error messages to the rsasoc/nohup.out file.

Upstart Logs

The Reporting Engine appends the log messages and output written by upstart daemon and the
commands used to start the reporting-engine to the /var/log/secure directory.

An upstart log file is a system log file so only the root user can read it. The Reporting
Engine generates log files, retains backup copies of previous log files, stores UNIX script log
files, and appends upstart log files to another directory.
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Search and Export Historical Logs

NetWitness Suite provides a searchable view of the NetWitness Suite log or the service log in
a paged format. When initially loaded, the grid shows the last page of the log entries for the
system or the service. You can export logs from the current view.

Display the Historical System Log
To display the historical log for the system:
1. Goto ADMIN > System.
2. In the options panel, select System Logging.
The System Logging panel is opened to the Realtime tab by default.
3. Click the Historical tab.

A list of historical logs for the system is displayed.
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Display a Historical Service Log

To display the historical log for services:
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Select ADMIN > Services.

Select a service.

In the Actions column, select View > Logs.

The service logs view is displayed with the Realtime tab open.
Click the Historical tab.

A list of historical logs for the selected service is displayed.

RSA RESPOND  INVESTIGATE MONITOR CONFIGURE ADMIN

Services

% Change Service | B nwappliance13731 - Broker

[Va)
%]
™
=
r
o

Start Date B EndDate B ALL v| Keywaord Broker v | Search 1 Export

Message

=S ST =A, L= Reston, 0= R54, QU = Nediiess, CN = 31726067

als. Using supplied value 5.

tials. Using supplied valu

Displaying 301 - 350 of 350

Search Log Entries

To search the results shown in the Historical tab:

L.

(Optional) Select a Start Date and End Date. Optionally, select a Start Time and End

Time.

(Optional) For system and service logs, select a Log Level and a Keyword, or both. System
logs have seven log levels. Service logs have only six log levels because they do not include
the TRACE level. The default is ALL log entries.

(Optional) For service logs, select the Service: host or service.
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4. Click Search.
The view is refreshed with the most recent 10 entries matching your filter. As new matching

log entries become available, the view is updated to show those entries.

Show Details of a Log Entry

Each row of the Historical tab Log grid provides the summary information of a log entry. To
display all the details for a log message:

1. Double-click a log entry.

The Log Message dialog, which contains the Timestamp, Logger Name, Thread, Level and
Message, is displayed.

Log Mes=sage

Timestamp 201 7-0e-22T07:47:12.000

Logzer Mame Engine
Thread
Level AUDIT

IMezzage Uzer escalateduser (session 343, 10.31.125.240:35328) has logged
out

2. After viewing, click Close.

The dialog closes.

Page Through Log Entries

To peruse the different pages of the grid, use the paging controls on the bottom of the grid as
follows:

o Use the navigation buttons

o Manually type the page number you want to view, and press ENTER.

Export a Log File

To export the logs in the current view:

Click Export, and select one of the drop-down options: CSV Format or Tab Delimited.

The file is downloaded with a filename that identifies the log type and the field delimiter. For
example, a NetWitness Suite system log exported with comma-separated values is named UAP_
log_export_CSV.txt, and a host log exported with tab-separated values is named
APPLIANCE_log _export_TAB.txt.
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Maintaining Queries Using URL Integration

A URL integration provides a way to represent the bread crumbs, or query path, you take when
actively investigating a service in the Navigate view. You do not need to display and edit these
objects often.

A URL integration maps a unique ID that is automatically created each time you click on a
navigation link in the Navigation view to drill into data. When the drill-down completes, the
URL reflects the query IDs for the current drill point. The Display Name is displayed in the
bread crumb in the Navigate view.

The URL Integration panel provides a list of queries and allows users who have the proper
permissions to modify this underlying source of data and analyze the query patterns of other
users of the NetWitness Suite system. Within the panel, you can:

o Refresh the list.

o Edit a query.

o Delete a query.

o Clear all queries in the list.

Caution: After a query has been removed from the system, any Investigation URLs that
included the ID of that query will no longer function.

Edit a Query

1. Goto ADMIN > System.

2. In the options panel, select URL Integration.

URL Integration

= [ | ORefresh & Clear

O Display Name

Query Usermame When Created ~

O o nwappliance11639 did ="nwappliance 11639 admin Tue Jul 11 2017 06:40:09 +00:00 (UTC)
[ threat.category ="spe...  threat.category = 'spectrum’ admin Tue Jul 11 2017 08:3%:33 +00:00 (UTC)
O 2 content = 'specrum.C..  COMTENT = 'spectrum.consume’ admin Tue Jul 11 2017 08:41:33 +00:00 (UTC)
O s content = 'spectrum.a..  content='spectrum.analyze’ admin Tue Jul 11 2017 08:46:09 +00:00 (UTC)
O a4 Ewu.edu domain.dst ="gwu.edu’ admin Tue Jul 11 2017 09:37:28 +00:00 (UTC)
0 s 10.100.33.1 ip.src=10.100.33.1 admin Wed Jul 12 2017 08:48:56 +00:00 (UTC)
O s ip.src="127.0.0.1" ip.src=127.0.0.1 admin Wed Jul 12 2017 09:35:24 +00:00 (UTC)
O 7 tep.sreport = 34004 tep.srepart = 54004 admin Wed Jul 12 2017 09:37:44 +00:00 (UTC)
O s nwappliance23912 did ="nwappliance23912° admin Wed Jul 12 2017 11:09:05 +00:00 (UTC)
O @ gwu.edu domain.sre = gwu.edu’ admin Thu Jul 13 2017 13:58:52 +00:00 (UTC)
O 1o OTHER service =0 admin Fri Jul 14 2017 04:56:50 +00:00 (UTC)

O 11 test dom alert = test dom’ admin Fri Jul 14 2017 09:5%:43 +00:00 (UTC)

| Page 1 | of1 |

I c

Displaying1-12of 12
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3. Select the row in the grid and either double-click the row or click 3

The Edit Query Dialog is displayed.

Display Mame

Query

content = 'spectrum.consume’

content = 'spectrum.consume’

Cancel Save

4. Edit the Display Name and the Query, but do not leave either field blank.

5. To save the changes, click Save.

Delete a Query

Caution: After a query has been removed from the system, any Investigation URLs that
included the ID of that query will no longer function.

To remove a query from NetWitness Suite entirely:

1.

2.

Clear All Queries

Select the query.

Click ~—

A dialog requests confirmation that you want to delete the query.

Click Yes.

To clear all queries from the list:

Crick & Clear

The entire list is cleared.
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Use a Query in a URI

URL Integration facilitates integrations with third-party products by allowing a search against
the NetWitness Suite architecture. By using a query in a URI, you can pivot directly from any
product that allows custom links, into a specific drill point in the Investigation view in
NetWitness Suite.

The format for entering a URI using a URL-encoded query is:

http://<nw host:port>/investigation/<serviceld>/navigate/query/<encoded

query>/date/<start date>/<enddate>

where

o <nw host: port> is the IP address or DNS, with or without a port, as appropriate (ssl
or not). This designation is only needed if access is configured over a non-standard port
through a proxy.

o <serviceld> is the internal Service ID in the NetWitness Suite instance for the
service to query against. The service ID can be represented only as an integer. You
can see the relevant service ID from the url when accessing the investigation view
within NetWitness Suite. This value will change based on the service being connected

to for analysis.

o <encoded query> is the URL-encoded NetWitness Suite query. The length of query
is limited by the HTML URL limitations.

o <start date> and <end date> define the date range for the query. The format is
<yyyy-mm-dd>T<hh:mm>. The start and end dates are required. Relative ranges (for

example, Last Hour) are not supported in this version. All times are run as UTC.

For example:
http://localhost:9191/investigation/12/navigate/query/alias %20exists/date/2012-09-
017T00:00/2012-10-31T00:00

Examples

These are query examples where the NetWitness Server is 192.168.1.10 and the servicelD is
identified as 2.

All activity on 03/12/2013 between 5:00 and 6:00 AM with a hostname registered

o Custom Pivot: alias.host exists

o https://192.168.1.10/investigation/2...13-03-12T06:00
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All activity on 3/12/2013 between 5:00 and 5:10 PM with http traffic to and from IP address
10.10.10.3

o Custom Pivot: service=80 && (ip.src=10.10.10.3 || ip.dst=10.0.3.3)
o Encoded Pivot Dissected:

o service=80 => service&3D80

o ip.src=10.10.10.3 => ip%2Esrc%3D10%2E10%2E10%2E3

o ip.dst=10.10.10.3 => ip%2Esrc%3D 10%2E10%2E10%2E3

o https://192.168.1.10/investigation/2...13-03-12T17:10

Additional Notes

Some values may not need to be encoded as part of the query. For example, commonly the IP src
and dst is used for this integration point. If leveraging a third-party application for integration of
this feature, it is possible to reference those without encoding applied.
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FIPS Support

NetWitness Suite 11.0 ships with FIPS-validated 140-2 Cryptographic Modules that support all
cryptographic operations within NetWitness Suite. NetWitness Suite leverages two modules that
support a level 3 design assurance:

« RSA BSAFE Crypto-J

o OpenSSL with BSAFE (OWB)

Both modules have been certified with an operational environment comparable to the standard
NetWitness Suite configuration.

By default, the cryptographic modules enforce the usage of FIPS-certified cipher suites
wherever possible. For exceptions, refer to the information below and to the release notes. For
additional information about the FIPS modules, see
http://csre.nist.gov/groups/STM/cmvp/documents/140-1/140val-all. htm.

The RSA BSAFE Crtypo-J FIPS Certificate number is 2468 and the OWB FIPS Certificate is
included in the RSA BSAFE Crypto-C Micro Edition with certificate number 2300.

In 11.0.0.0, FIPS is enabled on all services except Log Collector. This includes Log Decoder
and Decoder if they were FIPS-enabled in 10.6.4.x. FIPS cannot be disabled on any services
except for Log Collector, Log Decoder and Decoder.

Note: For a fresh installation of 11.0.0.0, by default, all core services will be FIPS enforced
except Log Collector and Log Decoder. FIPS cannot be disabled on any services except for
Log Collector, Log Decoder and Packet Decoder.

Note: For upgrades to 11.0.0.0 from 10.6.4.x, the following conditions apply for the Log
Collector, Log Decoder and Decoder services:

- Log Collector is not FIPS enabled after upgrading to 11.0.0.0, even if FIPS was enabled in
10.6.4.x. You must enable FIPS support after upgrading to 11.0.0.0. See the instructions in FIPS
support for Log Collectors.

- If FIPS was enabled for the Log Decoder and Packet Decoder services in 10.6.4.x, FIPS will
also be enabled in 11.0.0.0. However, if Log Decoder and Packet Decoder were NOT FIPS
enabled in 10.6.4.x, they will not be enabled in 11.0.0.0, and you can manually enable FIPS for
these services if required. See the instructions in FIPS support for Log Decoders and Decoders.

FIPS support for Log Collectors

To enable FIPS for Log Collectors:
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. Stop the Log Collector service.

Open the /etc/systemd/system/nwlogcollector.service.d/nwlogcollector-

opts-managed. conf file.

Change the value of the following variable to off as described here:
Environment="OWB ALLOW NON FIPS=on"

to

Environment="OWB ALLOW NON FIPS=off"

Reload the system daemon by running the following command:

systemctl daemon-reload
Restart the Log Collector service.

Set the FIPS mode for the Log Collector service in the Ul :

Note: This step is not required if you are upgrading from 10.6.4 to 11.0.0.0 and FIPS was
enabled in 10.6.4.

a. Goto ADMIN > Services.
b. Select the Log Collector service and go to View > Config.

c. In SSL FIPS Mode, select the checkbox under Config Value and click Apply.

FIPS support for Log Decoders and Decoders

To enable FIPS for Log Decoders and Decoders that did not have FIPS enabled in 10.6.4.x:

1.

Go to ADMIN > Services and select a Log Decoder or Packet Decoder service.

2. Select View > Config, and in System Configuration, enable SSL. FIPS Mode by selecting
the check box in the Config Value column.

3. Restart the service.

4. Click Apply.
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Troubleshoot NetWitness Suite

For information about troubleshooting NetWitness Suite, see the following topics:

e Debugging Information

o Error Notification

e Miscellaneous Tips

NwLogPlayer

Troubleshoot Feeds

Debugging Information

NetWitness Suite Log Files

The following files contain NetWitness Suite log information.

CEIC

rabbitmq /var/log/rabbitmq/nw@]localhost.log
/var/log/rabbitmg/nw(@localhost-sasl.log

collectd /var/log/messages

nwlogcollector /var/log/messages

nwlogdecoder /var/log/messages

sms /opt/rsa/sms/wrapper.log

sms /opt/rsa/sms/logs/sms.log

sms /opt/rsa/sms/logs/audit/audit.log

NetWitness Suite /var/lib/netwitness/uax/logs/nw.log
NetWitness Suite /var/lib/netwitness/uax/logs/ audit/audit.log

NetWitness Suite /opt/rsa/jetty9/logs
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Files of Interest

The following files are used in key NetWitness Suite components, and can be useful when trying
to track down miscellaneous issues.

I N

RabbitMQ configuration file. This

configuration file partially drives
rabbit /etc/rabbitmg/rabbitmq.config the behavior of RabbitMQ,

particularly around network/SSL

settings.

RabbitMQ environment
configuration file. This file

rabbit /etc/rabbitmg/rabbitmg-env.conf specifies the RabbitMQ node name
and location of the enabled plugins

file.

This file specifies the list of
enabled plugins in RabbitMQ. This
file is managed by the RabbitMQ
server, via the rabbitmg-plugins
rabbit /etc/rabbitmg/rsa_enabled plugins command. This file overrides the
/etc/rabbitmg/enabled plugins path,
in order to work around issues with
upgrading the Log Collector from

early versions.
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I N

The RabbitMQ trust store. This file

contains a sequence of PEM-
encoded X.509 certificates,
) ) represented trust CAs. Any clients
rabbit /etc/rabbitmg/ssl/truststore.pem )
that connect to RabbitMQ and
present a certificate that is signed
by a CA in this list is considered a

trusted client.
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I N

The RabbitMQ Mnesia directory.
Mnesia is the Erlang/OTP database

technology, for storing Erlang
objects persistently. RabbitMQ
uses this technology for storing
information such as the current set
of policies, persistent exchanges

and queues, and so forth.

Importantly, the msg_store
persistent and msg_store_transient
directories are where RabbitMQ

rabbit /var/log/rabbitmg/mnesia/nw@localhost ~stores messages that have been
spooled to disk, e.g., if messages
are published as persistent
messages, or which have paged off
to disk due to memory limitations.

Keep a close eye on this directory,
if the disk or memory alarms have

tripped in RabbitMQ.

Caution: Do not delete these
files manually. Use RabbitMQ
tools to purge or delete queues.
Modifying these files manually
may render your RabbitMQ
instance inoperable.

Error Notification

NetWitness Suite has a set of error message types associated with different components and
operations. NetWitness Suite displays feedback in the form of a simple error notification and a

log entry.
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When an error notification dialog is displayed, you have two options: simply acknowledge the
message or view the system log for more information.

'3  Trial License Expired

If you want to view the system log for more information when an error notification is displayed,
click View log. The log opens in the Administration > System view with a list of messages.
Timestamp and message level are also listed.

£ Administration § Devices |;| System

Realtime

ALL vl Ke Search
Timestamp Level Message

2014-03-14T19:01:40.501  WARN Failed setup yum service for device

2014-03-14719:02:53.907 ERROR  Unable to connect to endpoint vives://

2014-03-14T19:02:53.913  WARN Failed setup yum service for device

Logging 2014-03-14T19:03:23.925 ERROR  Timeout waiting for task. java.util.concurrent TimeoutException: Timeout waiting for task. at«
2014-03-14719:03:23.926  WARN Failed setup yum service for device

2014-03-14T19:03:23.941 ERROR  Unable to connect to endpoint

2014-03-14T19:03:23.942  WARN Failed setup yum service for device

2014-03-14719:03:36.2 ERROR  Unable to connect to endpoint

2014-03-14T19:03:36.11 WARN Error occurred during applying system updates YumSetupFs

2014-03-14T19:05:44.120 ERROR java.lang.Exception: Trial license does not match |

Miscellaneous Tips

Audit Log Messages

It can be useful to see which user actions result in which log message types in the
/var/log/messages file.

The event categories spreadsheet included in the log parser package in the NetWitness Suite
Parser v2.0.zip archive lists the event categories and the event parser lines to help with building
reports, alerts, and queries.
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NwConsole for Health & Wellness

RSA has added a command option called logParse in NwConsole. This command

option supports log parsing, a convenient way to check log parser without setting up the full
system to do log parse. For more information about the logParse command, at the command line,
type help logParse.

Thick Client Error: remote content device entry not found

Error: “The remote content device entry was not found,” generated for a correlation rule
applied to a concentrator.

Problem: in Investigation, if you click the correlation-rule-name meta value in the
Alert meta key, you do not get session information.

Solution: Instead of using correlation rules on decoders and concentrators, use ESA rules. The
ESA rules do record the correlation sessions that match the ESA rule.

View Example Parsers

Since flex and lua parsers are encrypted when they are delivered by Live, you cannot easily
view their contents.

However, some plain text examples are available
here: https://community.emc.com/docs/DOC-41108.

Configure WinRM Event Sources

The following Inside EMC article has a video that walks through the process of setting up
Windows RM (Remote Management) collection: https://inside.emc.com/docs/DOC-122732.

Additionally, it contains two scripts that are shortcuts for procedures described in the "Windows
Event Source Configuration Guide."

NwLogPlayer

NwLogPlayer is a utility that simulates syslog traffic. In the hosted environment,
NwLogPlayer.exe is a command line utility located on the RSA NetWitness® Suite
Client machine in the following directory:

C:\Program Files\NetWitness\NetWitness 9.8

NwLogPlayer is also located on the Log Decoder host in /usr/bin.

Usage

At the command line, type nwlogplayer.exe -h to list the available options, as reproduced
here:
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--priority arg

-h [ --help ]

-f [ --file ] arg

(=stdin)

-d [dir ] arg

-s [ —--server ]

arg (=localhost)

-p [ --port ] arg
(=514)

-r [ --raw ] arg
(=0)

-m [ —--memory ]
arg

--rate arg

--maxcnt arg

-C [ R

multiconn ]
-t [ --time ] arg

-v [ —--verbose ]

set log priority level
show this message

input message; defaults to stdin

input directory

remote server; defaults to localhost

remote port; defaults to 514

Determines raw mode.

o 0 =add priority mark (default)

o 1="File contents will be copied line by line to the server.
e 3 =auto detect

o 4 =enVision stream

o 5 =binary object

Speed test mode. Read up to 1 Megabyte of messages from the file

content and replays.

Number of events per second. This argument has no effect if rate >

eps that the program can achieve in continuous mode.
maximum number of messages to be sent

multiple connection

simulate time stamp time; format is yyyy-m-d-hh:mm: ss
If true, output is verbose
simulate an [P tag

use SSL to connect

Troubleshoot NetWitness Suite
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--certdir arg OpenSSL certificate authority directory
--clientcert arg  yse this PEM-encoded SSL client certificate

—--udp send in UDP

Troubleshoot Feeds

Overview

The purpose of the feed generator is to generate a mapping of an event source to the list of
groups to which it belongs.

If you have an event source from which you are collecting messages, and yet it is not displayed
in the correct event source groups, then this topic provides background and information to help
you track down the problem.

Details

The ESM Feed maps multiple keys to single value. It maps the Device Address, Forwarder,
and DeviceType attributes to groupName.

The purpose of the ESM feed is to enrich event source Meta with the groupName collected on
the Log Decoder.

How it Works

The feed generator is scheduled to update every minute. However, it is triggered only if there
are any changes (create, update, or delete) in event sources or groups.

It generates a single feed file with event source to group mapping, and pushes the same feed to
all of the Log Decoders that are connected to NetWitness Suite.

Once the feed file is uploaded on the Log Decoders, for any new events, it enriches events Meta
data with groupName, and appends this groupName to logstats.

Once the groupName is in logstats, the ESM Aggregator groups information and sends it to
ESM. At this point, you should see the Group Name column under the Event Source
Monitoring tab.

The entire process can take some time. Therefore, you may need to wait for several seconds
after you add a new group or event source, before the Group name is displayed.

Note: If the event source type attribute changes when the feed is updated, NetWitness Suite
adds a new logstats entry, rather than updating the existing one. Thus, there will be

two different logstats entries in logdecoder. Previously existing messages would have been
listed under the previous type, and all new messages are logged for the new event source type.
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Feed File

The format of the feed file is as follows:

DeviceAddress, Forwarder, DeviceType, GroupName

The DeviceAddress is either ipv4, ipv6, or hostname, depending on which of these have
been defined for the event source.

The following is a sample of the feed file:

"12.12.12.12","d6", "NETFLOW", "grpl"
"12.12.12.12","1d4", "netflow", "grpl"
"12.12.12.12","d6e", "netfow", "grpl"
"0:E:507:E6:D4DB:E:59C:A","10.25.50.243", "apache", "Apachegrp"
"1.2.3.4","LCC", "apache", "Apachegrp"
"10.100.33.234","LC1", "apache", "Apachegrp"
"10.25.50.248","10.25.50.242", "apache", "Apachegrp"
"10.25.50.251","10.25.50.241", "apache", "Apachegrp"
"10.25.50.252","10.25.50.255", "apache", "Apachegrp"
"10.25.50.253","10.25.50.251", "apache", "Apachegrp"
"10.25.50.254","10.25.50.230", "apache", "Apachegrp"
"10.25.50.255","10.25.50.254", "apache", "Apachegrp"
"13.13.13.13","LC1", "apache", "Apachegrp"
"AB:F255:9:8:6C88:EEC:44CE:7",, "apache", "Apachegrp"

"Appliancel234",, "apache", "Apachegrp"

"CB:F255:9:8:6C88:EEC:44CE:7","10.25.50.253", "apache", "Apache

grp"

Troubleshooting

You can check the following items to narrow down where the problem is occurring.

Feed File Existence

Verify that the feeds ZIP archive exists in the following location:

/opt/rsa/sms/esmfeed.zip

Do not modify this file.
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Group Meta Populated on LD

Verify that the group meta is populated on the Log Decoder. Navigate to the Log Decoder REST
and check logstats:
http://LogDecoderIP:50102/decoder?msg=logStats&force-content-

type=text/plain
This is a sample logstats file with group information:

device=apache forwarder=NWAPPLIANCE10304 source=1.2.3.4 count=338
lastSeenTime=2015-Feb-04 22:30:19 lastUpdatedTime=2015-Feb-04 22:30:19
groups=IP1234Group, apacheGroup

device=apachetomcat forwarder=NWAPPLIANCE10304 source=5.6.7.8
count=1301 lastSeenTime=2015-Feb-04 22:30:19 lastUpdatedTime=2015-Feb-

04 22:30:19 groups=AllOtherGroup,ApacheTomcatGroup
In the above text, the group information is bold.

Device Group Meta on Concentrator
Verify that the Device Group meta exists on the Concentrator, and that events have values for
the device.group field.

Device Group (8 values) L
testgroup (28.878) - localgroup (3,347) - squid (3.346) - allothergroup (780) - apachetomcatgroup (561) -ip1234group (457) - cacheflowelff (219) - apachegroup (31)

sessionid = 22133

time = 2015-02-05T14:35:03.0
size = 91

lc.cid = "NWAPPLIANCE10304"
forward.ip = 127.0.0.1

device.ip = 20.20.20.20
medium = 32

device.type = "unknown" =
device.group = "TestGroup”
kig_thread = "0

SMS Log File

Check the SMS log file in the following location to view informational and error messages:
/opt/rsa/sms/logs/sms.log

The following are example informational messages:
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Feed generator triggered...
Created CSV feed file.
Created zip feed file.

Pushed ESM Feed to LogDeocder : <logdecoder IP>

The following are example error messages:

Error creating CSV File : <reason>Unable to push the ESM Feed: Unable to
create feed zip archive.

Failed to add Group in CSV: GroupName: <groupName> : Error: <error>
Unable to push the ESM Feed: CSV file is empty, make sure you have al-
least on group with al-least one eventsource.

Unable to push the ESM Feed: No LogDecoders found.

Unable to push the ESM Feed: Unable to push feed file on LogDecoder-
<logdecoderIP>Unable to push the ESM Feed:
admin@<logdecoderIP>:50002/decoder/parsers received error: The zip
archive "/etc/netwitness/ng/upload/<esmfeedfileName>.zip" could not be
opened

Unable to push the ESM Feed: <reason>

Verify Logstats data is getting Read & Published by ESMReader & ESMAggregator

These are the steps to verify that logstats are collected by collectd and published to
Event Source Management.

ESMReader
1. On LogDecoders add debug "true" flag in /etc/collectd.d/NwLogDecoder ESM.conf:

#
# Copyright (c) 2014 RSA The Security Division of EMC
#
<Plugin generic_ cpp> PluginModulePath "/usr/lib64/collectd"
debug "true"
<Module "NgEsmReader" "all"> port "56002"
ssl "yes"
keypath "/var/lib/puppet/ssl/private keys/d4c6dcd4-6737-
4838-a2f7- ba7e9%al65aae.pem"

certpath "/var/lib/puppet/ssl/certs/d4c6dcd4-6737-4838-
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2.

a2f7- ba7e9%9al65aae.pem"

interval "600"

query "all"

<stats> </stats> </Module> <Module
"NgEsmReader" "update"> port "56002"

ssl "yes"

keypath "/var/lib/puppet/ssl/private keys/d4c6dcd4-6737-
4838-a2f7- ba7e9%9al65aae.pem"

certpath "/var/lib/puppet/ssl/certs/d4c6dcd4-6737-4838-

a2f7- ba7e9%9al65aae.pem"
interval "60"
query "update"
<stats> </stats> </Module></Plugin>

Run the command:

collectd service restart

Run the following command:
tail -f /var/log/messages | grep collectd
Verify that ESMReader is reading logstats and there are no errors. If there are any read

issues, you will see errors similar to the following:

Apr 29 18:47:45 NWAPPLIANCE15788 collectd[14569]: DEBUG: NgEsmReader

all: error getting ESM data for field "groups" from logstat

device=checkpointfwl forwarder=PSRTEST source=1.11.51.212. Reason:

<reason>Apr 29 18:58:36 NWAPPLIANCE15788 collectd[14569]: DEBUG:

NgEsmReader update: error getting ESM data for field "forwarder" from

logstat device=apachetomcat source=10.31.204.240. Reason: <reason>

ESMAggregator

I.

On NetWitness Suite, uncomment the verbose flag in /etc/collectd.d/ESMAggregator.conf:

# ESMAggregator module collectd.conf configuration file

#

# Copyright (c) 2014 RSA The Security Divsion of EMC

#

<Plugin generic_ cpp> PluginModulePath "/usr/lib64/collectd"
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<Module "ESMAggregator">
verbose 1
interval "eQ"
cache save interval "600"
persistence dir "/var/lib/netwitness/collectd"

</Module> </Plugin>

2. Run the following:

collectd service restart

3. Run the following command:
run “tail -f /var/log/messages | grep ESMA
Look for for ESMAggregator data and make sure your logstat entry is available in logs.

Sample output:

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator:
MetaData[0] logdecoder[0] = d4c6dcd4-6737-4838-a2f7-ba7e9%9al6baae
Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator:
MetaData[l] logdecoder utcLastUpdate[0] = 1425174451

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator:
MetaData[2] groups = Cacheflowelff,Mixed

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator:
MetaData[3] logdecoders = d4c6dcd4-6737-4838-a2f7-ba7e%alb65aae
Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator:
MetaData[4] utcLastUpdate = 1425174451

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator:
Dispatching ESM stat NWAPPLIANCE15788/esma_ update-cacheflowelff/esm

counter-3.3.3.3 with a value of 1752 for

NWAPPLIANCE15788/cacheflowelff/esm counter-3.3.3.3 aggregated from 1 log

decoders

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator:
MetaData[0] logdecoder[0] = 767354a8-5e84-4317-bc6a-52e4f4d8bfff
Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator:
MetaData[l] logdecoder utcLastUpdate[0] = 1425174470

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator:
MetaData[2] groups = Cacheflowelff,Mixed

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator:
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MetaData[3] logdecoders = 767354a8-5e84-4317-bc6a-52e4f4d8bfff
Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator:
MetaData[4] utcLastUpdate = 1425174470

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator:
Dispatching RRD stat NWAPPLIANCE15788/esma_ rrd-cacheflowelff/esm
counter-3.3.3.3 with a value of 1752 for

NWAPPLIANCE15788/cacheflowelff/esm counter-3.3.3.3 aggregated from 1 log

Configure JMX Feed Generator Job Interval

Although the feed generation job is scheduled to execute every minute by default, you can
change this by using jconsole, if necessary.

To change the feed generator job interval:

1. Open jconsole for the SMS service.

2. On the MBeans tab, navigate to com.rsa.netwitness.sms > API > esmConfiguration >
Attributes.

3. Modify the value for the property FeedGeneratorJobIntervallnMinutes.

4. Go to Operations under the same navigation tree, an click commit(). This persists the new
value in the corresponding json file under /opt/rsa/sms/conf, and uses the value if SMS is

restarted.

Setting a new value reschedules the feed generator job for the new interval.
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References

This section describes the NetWitness Suite user interface views in which you can perform
system maintenance tasks. You use this interface to:

o Monitor and maintain services (settings, statistics, command and message syntax, REST API,

RSA Console utility, and protocols supported in NetWitness Suite).
o Display the current NetWitness Suite version and license status.
o Manage your Local Update Repository from which you apply software version updates to

hosts.

The following topics describe each interface in detail:

o Health and Wellness View

e System View - System Info Panel

Health and Wellness View

The Health and Wellness settings allow you to set and view alarms, monitor events, and view
policies and system statistics. For more details on each of these, see the following topics:

o Health and Wellness View - Alarms View

o Event Source Monitoring View

o Health and Wellness Historical Graphs

o Health and Wellness Settings View - Archiver

o Health and Wellness Settings View - Event Sources

o Health and Wellness Settings View - Warehouse Connector

e Monitoring View

e Policies View

o System Stats Browser View

Health and Wellness View - Alarms View

You can monitor hosts and services to determine when user-defined limitations have been
reached by viewing all the active alarms. Policy rules, that you define or assign to hosts and
services, in the Policies tab trigger these alarms. You can:
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o View all the alarms that are currently active for all your systems and services

o Select an alarm and view its details

What do you want to do?

Administrator View the alarm status of NetWitness Monitor Alarms

Servers and services.

Administrator ~ View detailed information about a specific ~Monitor Alarms

alarm.

Related Topics
Manage Policies

Quick Look

The required permission to access this view is Manage services. To access the Alarms view,
20 to Admin > Health & Wellness. The Health & Wellness view opens with the Alarms tab
displayed. The Alarms tab contains an alarms list and an Alarm Details panel.

ADMIN

HEA WELLNESS

Manitoring Polidies System Stats Browser  Event Source Monitoring Settings

@

Contexthub Server

Rule Name W Agdress

Eroker Aggregation Stapoed

Stopped

Braker Aggrega

uming From Service ©
sion Rate Zers

zion Rate Zero

EBroker Session Rate Zero Broker/Session Rate (current)

Ieems 1 - 24 of 24

| Page |1 | oft | | © 2o Refresh

Time when the alarm was triggered.
Status of the alarm:
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o Active - the statistical threshold was crossed triggering the alarm.
e Cleared - the clearing threshold was crossed and the alarm is no longer active.
Rl Scverity assigned to this alarm:
e Critical
o High
e Medium
e Low
Name of the rule that triggers the alarm.
Service defined in the rule.
n Host on which the alarm is triggered.
Statistic selected in the rule that triggers the alarm.
n Value of the statistic that triggered the alarm.
n Identification number of the alarm.

Note: NetWitness Suite sorts the alarms in time order. You can sort the relevant parameters
in ascending or descending order.

This figure shows the Alarms tab with the Alarm Details panel expanded.
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HEALTH & WELLNESS

Policies Systemn Stats Browser  Event Source Monitoring  Settings

Alarm Details
Tiene - stare Severtty Hule Name

Active @ Critical  Contexthub Server if T

“
g
H
7
1R
2
|
»
H

MWAPFLIANCE170D0

Comexthub Server

Conzexthul Senver

zame of the services Health Checks are in a Critical[FATAL) state.

Check the services Health Checks statistics 1o determing the issus

Muoniter the senice rAog/ z/contescchub-server! for proper operation.

Processinfo Over, 15 o

ERROR

So0-5053e M50

NETWITNESS 5UIT 11.000.0-

Alarm Details Panel

The Alarm Details panel displays information for the alarm selected in the Alarms list. It
contains all the information in the Alarms list plus the following fields.

Alarm Notified time

Suppression start time
Suppression end time

Suppression start (selected time zone)
Suppression end (selected time zone)
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I8 [tem key

Event Source Monitoring View

Note: To manage Event Sources, see 'About Event Source Management' in the NetWitness
Suite Event Source Management Guide.

NetWitness Suite provides a way to monitor the statistics for various event sources in the User
Interface. The information displayed is historical and comes from the Log decoder. You can
customize the view depending on the parameter you select to filter the data.

To access the Event Source Monitoring view:

1. Goto ADMIN > Health & Wellness.
The Health & Wellness view is displayed with the Alarms tab open.

2. Click Event Source Monitoring.

What do you want to do?

Administrator View the Events Collected from  Historical Graph View for Events Collected

an Event Source from an Event Source

Related Topics

e Monitor Event Sources

o Filter Event Sources

o View Historical Graph of Events Collected for an Event Source

Quick Look

The Event Source Monitoring view is displayed.
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RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Healt

Alarms Monitoring ~ Policies  System Stats Browser WATWIEGIGCIVLNIGILT Settings ~ NWAPPLIANCE11639

Event Source Event Source Type Log Collector Log Decoder Time Frame Order By ﬁ—.
Any v Any v | Any v | |Any v | Any Ml Apply Clear Export as CSV

[(IRegex ®Received ONot Received @ Ascending ()Descending
Event Source Event Source Type Log Collector Log Decoder Count Idle Time Last Collected Time Historical Graph
10.31.246.60 cacheflowelff NWAPPLIANCE11639 NWAPPLIANCE11639 1 2 days, 2hours, 14min  2017-07-12 11:36:5 &
10.30.94.35 ciscoasa NWAPPLIANCE11639 PLIANCE11639 96 2 days, 5 hours, 5min  2017-07-12 h
10.31.125.249 netwitnessspectrum NWAPPLIANCE11639 NAPPLIANCE11639 2 2 days, Shours, 52 min  2017-07-1207:59:34 A... &
10.30.94.33 winevent_snare NWAPPLIANCE11639 NWAPPLIANCE11639 14 3 days, 2hours, 50 min  2017-07-11 &

| Page 1 of1 | | C Items 1 -4 of 4

NETWITNESS SUITE 11.0.0.0-170709005430.1.9127d8d

Displays Event Source Monitoring tab.
Toolbar used to filter and customize the Event Source Monitoring tab.
Displays Event Source Stats panel.

Filters

This table lists the various parameters you can use to filter and customize the event source
monitoring view.

Parameter | Description

Event Type the name of an event source you want to monitor.
Source Select Regex to enable Regex filter. It performs a regular expression search
against text and lists out the specified category. If Regex is not selected it

supports globbing pattern matching.

Event Select an event source type for the event source selected.

Source Type

Log Select the Log Collector to display the data collected by the specified Log

Collector Collector.

Log Decoder Select a Log Decoder to display the data collected by the specified Log

Decoder.
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Time Frame

Order By

Apply
Clear

Export as

CSv

Select the time frame for which you want the stats.

Select Received if you need the query results to contain only event sources that
logs have been received from within the selected time.

or

Select Not Received if you need the query results to contain only event

sources that logs have not been received from within the selected time

Select the order in which the list needs to be filtered.

Select Ascending to filter it in an ascending order.
Click to apply the filters chosen and display the list accordingly.
Click to clear the chosen filters.

Click to export the information as a csv file.

Event Source Stats View Display

Event Source

Event Source

Type
Log Collector
Log Decoder

Count

Idle Time

Last Collected

Time

Displays the name of the event source.

Displays the event source type.

Displays the Log Collector from where the events were initially captured.
Displays the Log Decoder where the events are being processed.

Displays the number of events received by Log Decoder since last reset of

count value.
Displays the time lapsed after the last stat collection.

Displays the time at which the Log Decoder last processed an event for the

event source
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Historical Graph Click i to view the historical graph of the stats collected for the event

source.

Health and Wellness Historical Graphs

Configuring the Archiver monitoring enables you to automatically generate notification when
critical thresholds concerning Archiver aggregation and storage have been met. The Historical
Graph view provides a visualization of historical data,

See the following topics for more details:

o Historical Graph View for Events Collected from an Event Source

o Historical Graph for System Stats

Historical Graph View for Events Collected from an Event Source

The Historical Graph view for events collected from an event source provides a visualization of
historical data. To access this view:

1. Goto ADMIN > Health & Wellness.

The Health & Wellness view is displayed with the Monitoring tab open.
2. Click Event Source Monitoring.

The Event Source Monitoring view is displayed.
3. In the Historical Graph column, select i

The Historical graph for the selected event source type is displayed in a popup window.
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The figure displays the events collected from the event source type winevent_snare.

Historical Graph

winevent_snare: 10.30.94.35 Time Frame Current Day v
Zoom 1h 6h 12h 1d Al From | Jul 9, 2017 To | Jul 10,2017
0.0075
0.005 @
A
0.0025
! :
21:00 10. Jul 03:00 06:00 09:00 12:00 15:00 18:00
Al b
10. Jul 06:00 2 AR=Hr
‘ i | v
— average
Click and drag in the plot area to zoom in

You can customize the graph as required. The table lists the various parameters used to
customize the historical graph.

Time Frame Select the Time Frame for which you want to view the historical data. The

available options are: Current Day, Current, Week, Current Month.

From <date> Select the date range for which you want to view the historical data.

To <date>

You can zoom in for a detailed view of the data in the Historical graph.
Zoom In Function 1 and 2

You can select one of the values to view the historical data for the selected value. The figure
below displays an example for the 6h frame selected for zoom in. The slider bar at the right
bottom corner is also changed to a 6h window.

Alternatively, you can slide the bar in the right hand corner to zoom in to a required frame.
Zoom In Function 3

You can click and drag in the plot area to zoom in for a required frame of time.

Historical Graph for System Stats

To access the Historical Graph for the System Stats:
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1. Goto ADMIN > Health & Wellness.
The Health & Wellness view is displayed with the Alarms tab open.
2. Click the System Stats Browser tab.

The System Stats Browser tab is displayed.
3. In the Historical Graph column, select b

The Historical graph for the selected statistic for a host is displayed.

The figure displays the system stats view for the Memory Utilization statistics.

Historical Graph

Host: Memory Utilization Time Frame Current Day v
Zoom 1h 6h 12h 14 Al From | Jul 9, 2017 To | Jul 10, 2017
15.5
19
g
£
185 ®
18
17.5
21:00 10, Jul 03:00 06:00 0%9:00 12:00 15:00 18:00
10. Jul 06:00 /—""_’/]_FZZOO 8:00
‘ in '
—— average
Click and drag in the plot area to zoom in

Parameters

You can customize the graph view as required. The table lists the various parameters used to
customize the historical graph view.

Time Frame Select the time frame for which you want to view the historical data.
The available options are: Current Day, Current Week, Current

Month, and Current Year.

From <date> To  Select the date range for which you want to view the historical data,

<date>

You can zoom in for a detailed view of the data in the Historical graph.
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Zoom in function 1 and 2:

You can select one of the values to view the historical data for the selected value. The figure
below displays an example for the 6h frame selected for zoom in. The slider bar at the right
bottom corner is also changed to a 6h window.

Alternatively, you can slide the bar in the right hand corner to zoom in to a required frame.

Historical Graph

Host: Mounted Filesystem Disk Usage Percent Time Frame | Current Moml v
Zoom 1w 2w 3w Im All From | Jun 29, 2017 | To | Jul 14, 2017
7
55
s §
E
mw
5.5
5
45
30. Jun 2. Jul 4 Jul 6. Jul 8. Jul 10. Jul 12, Jul 14, Jul
-
19. Jun 26. Jun 3. Ju 10 jull
] m »
average
Click and drag in the plot area to zoom in

Zoom in function 3:
You can click and drag in the plot area to zoom in for a required frame of time.

The figure below displays an example of how the graph appears while you click and drag.
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Historical Graph

Host: Mounted Filesystem Disk Usage Percent Time Frame | Current Momi v
Zoom Tw 2w 3w Im Al From | Jul 10, 2017 To | Jul 13, 2017
7
Tuesday, Jul 11, 18:00 &5
@ average: 6.00
¥ 6 &
=
w

Al .
/ :

08:00 16:00 11, Jul 08:00 16:00 12, Jul 08:00 16:00 13. Jul 08:00

19. Jun 26. Jun 3. Jul

— average

Click and drag in the plot area to zoom in

Health and Wellness Settings View - Archiver

Note: To monitor Archiver and Warehouse Connector, see Health Policy.

To access the Archiver Monitoring view:
1. Go to Administration > Health & Wellness.

2. Select Settings > Archiver.

What do you want to do?

Administrator Monitor service details of Archiver Monitor Service Details

Related Topics

Monitor Service Details
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Quick Look

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Health & Wellness

Alarms  Monitoring ~ Policies  System Stats Browser Event Source Monitoring [REadu ]

To monitor Event Sources, see Event Source Management. To monitor Archiver and Warehouse Connector, see Health Policy
Event Source | Archiver, = Warehouse Connector
—
Archiver Monitoring +«—H

These settings allow for notifications to be generated when critical thresholds concerning Archiver aggregation and
storage have been met.

Aggregation Status
Notify After S v

For Clrailed [ offline

Aggregation Connection

Notify After Failing For < Minutes v

Storage Connection

Notify After Failing For < Minutes v

Storage Capacity

Storage Threshold By Space Time

IBl Displays Archiver Monitoring Panel

A Configure Archiver Monitoring Panel to automatically receive notification

Features

The following table lists the parameters required to configure the Archiver to automatically
generate notification when critical thresholds are reached.

| Parameter | Value Description

Aggregation Notify After Number of minutes or hours after which the you will get

Status notified of the Aggregation status
For Failed - If enabled, you get notification when the

Archiver aggregation status is failed for the defined

number of minutes or hours.

Offline - If enabled, you get a notification when the

Archiver aggregation status is offline for the defined

number of minutes or hours
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. Aggregation

+ Connection

Storage

+ Connection

' Storage
Capacity

Notify After
Failing for

Notify After
Failing for

Storage Threshold
By

When Storage Size
Is

When Warm

Storage Size Is

Number of minutes or hours after which you will receive
a notification if the Archiver aggregation connection

fails.

Number of minutes or hours after which you will receive
a notification if the Archiver storage connection fails.
Select Space, if you want to receive a notification when

the Archiver storage capacity exceeds the percentage
defined in the When Storage Size Is field.

Select Time, if you want to receive a notification when
the files stored in the Archiver exceeds the defined
number of days in the When Oldest Storage File

Is field

Enter what percent full the storage size should be if you

want to receive a notification.

Enter what percent full the warm storage size should be
if want to receive a notification.

Notification ~ Configure email or ~ Click to configure email so that you can receive
3 o notifications in NetWitness Suite.
» Type distribution list
Configure Syslog Click to configure audit logs.
and SNMP Trap
servers
NW Console, Enable NW Console to get notifications on the
. NetWitness Suite Ul notification toolbar.
Email,
Enable Email to get email notifications.
) : Enable Syslog Notification to generate syslog events.
Syslog Notification,
SNMP T Enable SNMP Trap Notification to get audit events as
rap SNMP traps.
Notification
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Health and Wellness Settings View - Event Sources

Note: To manage Event Sources, see About Event Source Management in the RS4
NetWitness Suite Event Source Management Guide.

The Event Source Monitoring view consists of the Event Source panel, Add/Edit Source Monitor
dialog, Decommission panel, and the Decommission dialog. You use the view to configure:

« When to generate notifications for event sources from which the Log Collector is no longer

receiving logs.
o Where to send those notifications.

o When to decommission a Log Collector when a Remote Collector and the Local Collector

fails over to a standby Log Decoder.

The required role to access this view is Manage NW Auditing. To access this view:

1. Go to Admin > Health & Wellness.

2. Select Settings > Event Source.

What do you want to do?

Administrator  View the functionality of Event Source Monitoring Monitor Event Sources

Related Topics

Configure Event Source Monitoring
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Quick Look

The Event Source tab is displayed.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Health & Wellness

Alarms  Monitoring ~ Policies  System Stats Browser Event Source Monitoring [REadu ]

To monitor Event Sources, see Event Source Management. To monitor Archiver and Warehouse Connector, see Health Policy

Event Source Archiver Warehouse Connector

Event Source Monitoring <~

These setting dictate when to generate notifications for event sources that the system is no longer receiving logs from and where to
send those notifications.

+

Regex  Source Type Source Host Time Threshold

Hours. Minutes

IB Displays Event Source Monitoring Panel

VA Configure Event Source Monitoring Panel to receive notification

Event Source Monitoring Panel

Description

Configure email ~ Opens the Administration > System > Email view so you can adjust the

or distribution list. email distribution for the Event Source Monitoring output, if necessary.

Configure Syslog  Opens the Administration > System > Auditing view so you can adjust
and SNMP Trap  the Syslog and SNMP trap distribution for the Event Source Monitoring

servers. output, if necessary.

+ Displays the Add/Edit Source Monitor dialog in which you add or modify

event sources to monitor.

- Deletes the selected event sources from monitoring.
[E Selects an event source.
Source Type Displays the source type of the event source.
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e oo

Source Host Displays the source host of the event source.

Time Threshold Displays the time period after which NetWitness Suite stops sending
notifications (Time Threshold).

Apply Applies any additions, deletions, or changes and they become effective
immediately.
Cancel Cancels any additions, deletion, or changes.

Decommission Panel

o o

+ Displays the Decommission dialog in which you add or modify event sources to

decommission.

Deletes the selected event sources from decommissioning.

Selects an event source.

Regex Displays if you choose to use regular expressions
Source Type Displays the source type of the decommissioned event source.

Source Host Displays the source host of the decommissioned event source.

Apply Applies any additions, deletions, or changes and they become effective
immediately.
Cancel Cancels any additions, deletions, or changes.
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Add/Edit Source Monitor Dialog

Add/Edit Source Monitor

L] Regex

Source Type *

Source Host *

0 £ | Hours

Time Threshold *

0

Minutes

<>

In Add/Edit Source Monitor dialog, you add or modify the the event sources that you want to
monitor. The two parameters that identify an event source are Source Type and Source Host.
You can use globbing (pattern matching and wildcard characters) to specify the Source Type

and Source Host of event sources as shown in the following example:

Source
Type

ciscopix

*

1.1.1.1

1.1.1.1

1.1.1.1]1.1.1.2
LLL[1]2]
1.1.1.[123]
1.1.1.[0-9]
1.1.1.11[0-5]
1.1.1.1L,1.1.1.2

1.1.1.[0-9](1.1.1.11[0-5]
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Source
Type

*

Features

1.1.1.[0-9]|1.1.1.11[0-5],10.31.204.20
1.1.1.*

1.1.1.[0-9]{1,3}

s Jowan

Regex

Source Type

Source Host

Time

Threshold

Cancel

OK

Select the checkbox if you want to use regular expressions

The source type of the event source. You must use the value that you
configured for the event source in the Event Sources tab of the
Administration > Services > Log Collector service > View > Config

View.

Hostname or IP address of the event source. You must use the value that
you configured for the event source in the Event Sources tab of the
Administration > Services > Log Collector device > View > Config

view.

The time period after which NetWitness Suite starts sending

notifications.

Closes the dialog without adding the event source, or changes to the

event source, to the Event Source Monitoring panel.

Adds the event source to the Event Source Monitoring panel.
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Decommission Dialog

Decommission

W Regex

Source Type *  apache

Source Host *

Cancel

m Description
Source The source type of the event source. You must use the value that you configured
Type for the event source in the Event Sources tab of the Administration > Services

> Log Collector device > View > Config view.

Source Hostname or IP address of the event source. You must use the value that you
Host configured for the event source in the Event Sources tab of the Administration >

Services > Log Collector service > View > Config view.

Cancel Closes the dialog without applying any event source additions, deletions, or

changes to the Decommissioning panel.

OK Applies any event source additions, deletions, or changes to the Decommissioning

panel.

Health and Wellness Settings View - Warehouse Connector

Note: To monitor Archiver and Warehouse Connector, see Health Policy.

Configuring the Warehouse Connector monitoring enables you to automatically generate
notification when critical thresholds concerning Warehouse Connector and storage have been
met.
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Access the Warehouse Connector Monitoring view

1. Go to Admin > Health & Wellness.

2. Select Settings > Warehouse Connector.

What do you want to do?

Administrator View the details of Warchouse connector ~Warehouse Connector Details View

Related topics

Warehouse Connector Details View

Monitor Service Details

Quick Look

The Warehouse Connector Monitoring view is displayed.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN !;@\udmin

He

Alarms  Monitoring ~ Policies  System Stats Browser  Event Source Monitoring [SSIT

To monitor Event Sources, see Event Source Management. To monitor Archiver and Warehouse Connector, see Health Policy

EventSource | Archiver | Warehouse Connector *—

Warehouse Connector Monitoring «—H

These settings allow for notifications to be generated when critical thresholds concerning Warehouse Connector
and storage have been met.

Source or Destination Status

Notify Offline For < |Minutes v

Stream Status

Notify Stopped For < |Minutes v
DiskIs S %Full
Source Is Behind 4 sessions
Rejected Folder Size Is $ %Full

Number Of Files In Permanent
Failure Folder

Notification Type

ure email o

11.0.0.0-170824160200.1.64b1a3b

Displays Warehouse Connector Monitoring view Panel

Allows to configure Warehouse Connector Monitoring parameters

Warehouse Connector Monitoring parameters

The following table lists the parameters required to configure the Warehouse Connector to
automatically generate notification when critical thresholds are reached.
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Source or Notify Offline For Number of minutes or hours after which the you will
Destination receive a notification if the source or destination

Status connection fails.

Stream Notify Stopped For ~ Number of minutes or hours after which you would like
Status to receive a notification when the Stream goes offline.

Disk Is The limit on the percentage of disk usage after which
you would like to receive a notification.

Source Is Behind Number of sessions after which a notification is raised
if the source goes behind the defined number of
sessions.

Rejected Folder Size Limit on the percentage of folder usage after which you

Is would like to receive a notification.

Number Of Files in  Limit on the number of files in the permanent failure

Permanent Failure folder after which you would like to receive a

Folder notification.

Notification  Configure email or Click to configure email so that you can receive
Type distribution list notifications in NetWitness Suite.

Configure Syslog Click to configure audit logs.

and SNMP Trap

servers

NW Console, Enable NW Console to get notifications on the

Email, NetWitness Suite Ul notification toolbar.

Syslog Notification, Enable Email to get email notifications.

SNMP Trap Enable Syslog Notification to generate syslog events.

Notification Enable SNMP Trap Notification to get audit events as
SNMP traps.
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Monitoring View

NetWitness Suite provides detailed statistics and other information about the host and the
individual NetWitness Suite services on Details views. You can view the current health of all
the hosts, services running on the hosts, various aspects of the hosts’ health, host details and
service details in the Monitoring view.

To access this view:
1. Goto ADMIN > Health & Wellness.
2. Click the Monitoring tab.

What do you want to do?

Administrator View and Perform Procedures Monitor Hosts and Services

Related Topics

e Monitor Hosts and Services

Quick Look

The Monitoring view is displayed.

CONFIGURE ADMIN @ admin ® (?)

3
Policies System Stats Browser  Event Source Monitoring  Settings NWAPPLIANCE10604
Groups Hosts Filter
Name Count ) i ) i §
Stopped Services Stopped Processing Physical Drive Problems Logical Drive Problems Full Filesystems
Sal
@ 0 4 0 hosti(s) 0 host(s) 1 host(s)
= NWAPPLIANCE10604 Status: @ CPU: 0.78% Memory: 9.43 GB/31.42 GB
Service Health Status |~ Rate Name Service Type cPU Memory Usage Uptime
@ Ready L - Event Stream Analysis Event Stream Analysis 0.1% 545GB 1 day 4 hours 25 minutes
@ Ready ® Contexthub Server 0% 1.20GB 1 day 4 hours 25 minutes
@ Ready o cs Serves Entity Behavior Analyt... 0% 645.89 MB 1 day 4 hours 25 minutes
B NWAPPLIANCE11639 Status: @ CPU: 1.36% Memory: 4.45 GB/31.42 GB
Service Health Status | Rate Name Service Type cPU Memory Usage Uptime
® Ready L ] Log Collector 1.5% 54.28 MB 4 hours 40 minutes 2 sec,
@ Ready 0 Log Decoder 2.5% 1.73GB 4 hours 40 minutes 2 sec
n R a0 am g e A lmiae A7 etimieae el T
| Page 1 of1 | | C Displaying 1 - 10 of 10

NETWITNESS SUITE 11.0.0.0-170709005430.1.9127d8x

Displays Monitoring tab.
Group Panel to select a Group.
Hosts panel displays operational statistics.
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Groups Panel

The Groups panel lists all the groups of hosts available. When you select a group, the associated
content is displayed in the Hosts panel.

Note: If the total host Count in the Groups panel is lower than the actual number of hosts
displayed in the Hosts panel, please refer to the Troubleshooting Health & Wellness topic for
possible causes of this issue and recommended solutions.

Hosts Panel

The Hosts panel displays operational statistics for hosts and the services running on each host.

Filter Type a host name or a service name in the Filter field to display the

corresponding hosts and services in the Host panel.

Stopped Click Stopped Services to display a list of all stopped services. It also displays
Services the host on which the service is installed.
Stopped Click Stopped Processing to display a list of all the hosts that have services

Processing installed on them that are in the stopped processing status.

Physical Click to view the hosts that have physical drive problems.
drive
Problems

<#> host(s)

Logical Click to view the hosts that have logical drive problems.
Drive
Problems

<#> host(s)

Full Click to view the hosts that have full file systems.
Filesystems

<#> host(s)

Note: The summary information in the boxes at the top displays the System Statistics for all
the hosts configured in NetWitness Suite and does not change with host of filters on groups.
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The top panel is followed by a list of hosts, the services installed on them and information
regarding the hosts and services.

Host Name  Displays the host name.

If a host has services installed you will see a E prefixed to the host

name.

Click g1 to view all the services installed on the host.

Status Displays the status of the Host.
@ - denotes that the host is active and running.

® - denotes that the host is stopped or yet to start processing.

CPU Displays the current CPU usage of the host.

Memory Displays the Memory used by the host.

When you click E prefixed to the host name, a list of all the services installed on the host is
displayed. The table below describes various parameters displayed for a service and their
description.

Service Displays the status of the service.

@ Ready - denotes that the service is active and running.

® Stopped - denotes that the service is stopped or yet to start processing.

Health Displays the processing status of the Service.
Status @ - denotes that the process is running and the data is being processed at a

rate greater than zero.

® - denotes that the processing is stopped.
@ - denotes that the processing is turned on but the data is not being processed.

Rate Denotes the rate at which the data is being processed.

Name Name of the service.
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Service Name of the type of service.

Type

CPU Displays the current CPU usage of the service.

Memory Displays the Memory used by the service.

Usage

Uptime Displays the time for which the service has been running.
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Archiver Details View

The Archiver Details view provides information about the Archiver. The following figure
depicts the Archiver Details.

RSA| RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Health

lness

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings NWAPPLIANCE25988 @

AosTANDSEReE Archiver Details

Host
Service

I Archiver

CPU 0.2% Used Memory 3293 MB
Running Since 2017-Jul-10 10:30:25 Max Process Memory 31.42GB
Build Date 2017-Jul-09 07:24:34 Version Information 11.0.00
Details
Aggregation State stopped Time Begin
Session Free Pages 0 Time End
Meta Free Pages 0 Session Rate Max ]
Database Status Session Rate 0
Database Session Rate Database Session Free Space
Database Session Rate Max Database Session Volume Bytes

NETWITNESS SUITE 11.0.0.0-170709005430.

For the related procedure, see Monitor Service Details

This section displays the current generic statistics for the service.

Description

Aggregation State of data aggregation.
State

Time Begin  Time (UTC) when the first session was tracked by the index.

Session Session pages available for aggregation.

Free Pages
Time End Time (UTC) when the last session was tracked by the index.

Meta Free  Pages available for aggregation.

Pages

Session Maximum sessions per second rate.

Rate Max
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Database
Status

Session

Rate

Database
Session

Rate

Database
Session

Free Space

Database
Session

Rate Max

Database
Session
Volume

Bytes

Status of databases. Valid values are:

o closed - not available for QUERY and UPDATE (databases are being

initialized). This value is seldom seen.
o opened - available for QUERY and UPDATE.

o failure - failed to open. This can happen for any number of reasons. You can
check this if CAPTURE fails to start or if queries fail to return data. This is

normally caused by database corruption.

Sessions per second rate.

Per second rate at which the service is writing sessions to the database.

Amount of session free space available for aggregation.

Maximum per second rate at which the service is writing sessions to the

database.

Number of session bytes in the database.
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Broker Details View

The Broker Details view provides information for the Broker. The following figure depicts the
Broker Details.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Health

liness

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings NWAPPLIANCE2943 @

HOST AND SERVICES o
Broker Details
Host
Service
I Broker
cPU 0.1% Used Memory 27.42 MB
Malware Analysis Y
Running Since 2017-Jul-1010:31:39 Max Process Memory 31.42GB
Build Date 2017-Jul-09 07:19:34 Version Information 11.0.0.0
Details
Aggregation State stopped Meta Rate 0

Session Rate Meta Rate Max 0

o o

Session Rate Max

| NETWITNESS SU 11.0.0.0-170709005430.1.9127d8d

For the related procedure, see Monitor Service Details.

This section displays the current generic statistics for the service.

Description

Aggregation State State of data aggregation.

Meta Rate Metadata objects per second rate.

Session Rate Sessions per second rate.

Meta Rate Max Maximum metadata objects per second rate.

Session Rate Max Maximum sessions per second rate.
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Concentrator Details View

The Concentrator Details view provides information for the Concentrator. The following figure
depicts the Concentrator Details.

RSA RESPOND  INVESTIGATE MONITOR CONFIGURE ADMIN () admin

Health & Wellness

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings NWAPPLIANCE10604 NWAPPLIANCE22655 @

Concentrator Details

Host

Service

I Concentrator
cPU 0.5% Used Memory 2.62GB
Running Since 2017-Jul-10 10:30:32 Max Pracess Memory 3142GB
Build Date 2017-Jul-09 07:1%:42 Version Information 11.0.0.0
Details
Aggregation State started Time Begin 2017-Jun-12 07:54:45
Meta Rate 0 Time End 2017-Jul-11 16:28:44
Meta Rate Max 97222
Session Rate a
Session Rate Max 1943

11.0.0.0-1

For the related procedure, see Monitor Service Details

The section displays the current generic statistics for the service.

Description

Aggregation State  State of data aggregation.

Time Begin Time (UTC) when the first session was tracked by the index.
Meta Rate Metadata objects per second rate.
Time End Time (UTC) when the last session was tracked by the index.

Meta Rate Max Maximum metadata objects per second rate.
Session Rate Sessions per second rate.

Session Rate Max Maximum sessions per second rate.
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Decoder Details View

The Decoder Details view provides information for the Decoder. The following figure depicts
the Decoder Details.

RSA' RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Health

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings NWAPPLIANCE2943 NWAPPLIANCE23912 @

HOST AND SERVICES

Decoder Details

Host
Py 2.6% Used Memory 271.64 MB A
I Decoder Running Since 2017-Jul-12 19:24:52 Max Process Memory 31.42 GB
Warehouse Connector Build Date 2017Jul-11 07:20:38 Version Information

Details

Capture Status started Meta Bytes 565.67 MB
Capture Kept 483 MB Meta Total 28302428
Capture Dropped 0 Packet Bytes 15.68 GB
Capture Dropped Percent 0% Packet Total 408513335
Capture Rate 0 Session Bytes 400K8
Capture Rate Max 0 Session Total 2712
Time Begin 2016-Sep-20 16:31:56 Pool Packet Write 0

Time End 2017-Jul-14 12:35:43 Poaol Packet Assembler 0
Assembler Packet Pages 37 Pool Packet Capture 49962

NETWITNESS SUIT 11.0.0.0-170709005430.1.9127d8d

For the related procedure, see Monitor Service Details.

This section displays the current generic statistics for the service.

Description

Capture Status of data capture. Valid values are:
Status « starting - Starting data capture (not capturing data yet).
o started- Capturing data.

« stopping- Stopping data capture (received request to stop data capture, but not

have not stopped capturing data yet).
o stopped - Not capturing data.

« disabled - Not configured as a Decoder service.

Meta Number of meta bytes in the database.
Bytes

Capture Number of packets kept during capture.
Kept
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Meta Number of metadata in the database.

Total

Capture Number of packets reported by the network card as dropped. After the service

Dropped  stops capturing data, rate is reset to zero.

Packet Number of packet bytes in the database.
Bytes

Capture Packets reported by the network card as dropped as a percentage.

Dropped

Percent

Packet Number of packet objects held in the packet database. The total decreases when

Total the database rolls files off due to size constraints. After the service stops
capturing data, the number is not reset.

Capture Megabits per second rate at which the service is capturing data. Rate is a rolling

Rate average sample over a short time period (10 seconds). After the service stops
capturing data, rate is reset to zero.

Session Number of session bytes in the database.

Bytes

Capture Maximum megabits per second rate at which the service is capturing data. Rate

Rate Max is a rolling average sample over a short time period (10 seconds). After the

service stops capturing data, displays the maximum rate during data capture.

Session Number of sessions held in the session database. This value shrinks when the
Total database rolls files off due to size constraints. After the service stops capturing

data, the number is not reset.

Time Time when first packet was captured (time when the first packet was stored in
Begin the packet database). This time increases as packets are rolled out of the packet
database.
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Pool Number of packet pages currently in the PCS pipeline that need to be written to

Packet the database.
Write

Time End Time when the last packet was captured (time when packet was written to the

database). The time increases as new packets are captured.

Pool Number of packet pages waiting to be assembled.
Packet

Assembler

Assembler Number of packet pages waiting to be assembled.
Packet

Pages

Pool Number of packet pages available for capture.
Packet
Capture

Event Steam Analysis (ESA) Details View

The Event Stream Analysis Details view provides information for ESA. The following figure
depicts the Event Stream Analysis Details.
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RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Service Event Sources Health

liness

Alarms Monitoring Policies = System Stats Browser ~ Event Source Monitoring  Settings [ LUENTE S [AER)

HOST AND SERVICES o
ESA Details
Host
Service
I Event Stream Analysis
CPU 0.2% Used Memory
Contexthub Server = ’
Runining Since 2017-Jul-11 10:37:31 Max Process Memory
Entity Behavior Analytics
Y it Build Date 2017-ul-09 03:33:32 Version Information
Details
Rules Menitor VM

Deployed Rule Memory Utilization Enable & Disable R

Name Event Stream Engine Average Estimated Memory (last hr)

dynarnicAlert

Local ESA (Default)

Local ESA (|

Local ESA (Default)

Local ESA(

Local ESA (Default)

‘ NETWITNESS SUITE

11.0.0.0-170709005430.1.9127d8d

For the related procedure, see Monitor Service Details.

This section displays the current generic statistics and Rule information for the service. It
consists of Rules, Monitor, and Java Virtual Machine (JVM) tabs that show Event Stream
Analysis rules and additional statistics.

Monitor tab

Displays the following generic statistical information for the Event Stream Analysis service:

o Average number of bytes received per event message field.
o Average number of bytes received per event message.

o Total number of bytes of bytes received.

o Total number of fields received.

o Number of rules deployed on the ESA Service. The Sum of Enabled rules and Disabled rules
should equal to Deployed

o Total number of events matched to all rules on the ESA service.

o Total number of events analyzed by the ESA Service since the last service start.
o Total number of alerts fired based on all the rules on the ESA service.

« Total dropped as late.

o Total fed on time.
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o Total exit early.

o Seconds between feeds.

o Time span in window.

o Total events in window.

o Percent window consumed.

o Total source work units.

o Total bus dropped by payload.

o Total bus dropped events.

o Total bus dropped by fields.

o Total number of alerts sent to the message bus.
o Total number of bus events.

o Total number of Bus work units.

o Total endpoints detected.

o Total lost endpoints.

o Total failed client count.

o Total successful client count.

o Total successful server count.

o Minutes since last success.

o Number of times proxy was requested and granted.
o Total successful requests.

o Number of times proxy was requested and not granted.

o Total unsuccessful requests.

ESA Analytics Details View

The ESA Analytics Details view provides health status information about the selected ESA
Analytics service. ESA Analytics services process the data for automated threat detection. It is
important that you address any checked item that shows a status other than green (healthy), so
that data processing is not interrupted and critical events are not missed.

The following figure shows the ESA Analytics Details view.
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HEALTH & WELLNESS SECURITY

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings NWAPPLIANCE10604 @

HOST AND SERVICES q .
Event Stream Analytics Server Details

Host
Service
Event Stream Analysis
CPU 0.1% Used Memo 653.36 MB
Contexthub Server v
Running Since 2017-u-13 08:04:02 Max Praocess Memory 31.42GB
Entity Behavior Analytics .
| Encey N y Build Date 20174ul-05 18:39:19 Version Information 11.0.00
Health Stats VM
Configuration Update Status Healthy Process Modules Healthy
Process JVM Memory Healshy Security PKI Certificate Healthy
Data Connection Healthy

| NETWITNES

11.0.0.0-170709005430.1.9127d8d

For the related procedure, see Monitor Service Details.

ESA Analytics Details

This section displays the current generic statistics for the selected ESA Analytics service.

Health Status

The Health Status section shows the health of the following items for the selected ESA
Analytics service:

« Mongo

JVM (Java Virtual Machine)

Disk Space

Suspicious Domains Module

o User Behavior Analytics Module

The following table describes the meaning of each health status.

Description
Green Healthy
Yellow Unhealthy
Red Critical and it needs immediate attention.
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Description

-- Inapplicable

Host Details View

The Host Details view provides information about a host. The following figure depicts the Host
Details.

RSA' RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Hea r

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings NWAPPLIANCE9 @

HOST AND SERVICES o
Host Details
I Host
System Info
Broker
Host NWAPPLIANCES Memory Utilization 69.18%
Reporting Engine . - Used Memory 21.74GB
Orchestration Server Running Since 2017-Jul-10 09:44:02 Total Memory 31.42GB
Security Server Current Time 2017Jul-11 16:43:42 Cached Memory 20568
TR S Uptime 1 day 6 hours 50 minutes 40 seconds Swap Utilization o
Used Swap 0 bytes
System Info a
i Linux 3.10.0-514.26.2.¢17.x86_64 x86_64
Config Server s SR Total Swap 400GB
Investigate Server
Respond Server Physical Drive | Logical Drive | File System Adapter Message Bus
State Enclosure Slot Failure Count  Raw Size Inquiry Data

11.0.0.0-

The options panel on the left displays the host and the services installed on the host. You can
click on Host any service to view the statistics and other pertinent information for that host or
service.

The Details panel displays information that is specific to the host and provides
additional information regarding the hardware of the host.

For the related procedure, see .Monitor Service Details

This section displays the current performance, capacity, and historical statistics for the host.

Parameter Description

Host Hostname.

CPU Current CPU usage of the host.
Running Since Time when the host was started.
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Current Time Current time on the host

Uptime

Time for which the host has been active.

System Info OS version installed on the host.

Memory Utilization Percentage of memory utilized by the host.

Used Memory Memory used in GB.

Total Memory Capacity of the memory installed on the system.

Cached Memory Memory that is cached to disk in GB.

Swap Utilization Percentage of system swap in use.
Used Swap Swap used in GB.
Total Swap Capacity of the swap installed on the system.

The lower section displays the current generic statistics for the host in the tabs described in the
following table.

Physical
Drive

Logical
Drive

File
System

Adapter

Type of physical drive, its usage and additional information of the physical drive on
the host.
Logical drive on the host.

File system information, the size, current usage and available capacity on the host.

Adapter used on the host.
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Message Publish In Rate - rate at which incoming messages are published to the message
Bus

bus queue.

Total Messages Queued - number of messages in the message queue.

Memory Used - amount of memory used by the message bus (in bytes).

Disk Free - free disk space available for the message bus (in bytes).

Memory Limit - system memory limit. If the memory usage exceeds this value,
this trips the Memory Alarm and Security Analytics stops accepting messages.
Disk Free Limit - limit of free disk space available for the message bus. If the
available disk space falls below this value, this trips the Disk Free Alarm and
Security Analytics stops accepting messages.

Memory Limit Available - Amount of memory available to this message broker
(in bytes) before the Memory Used Alarm is tripped.

Disk Limit Available - Amount of free disk space available to this message broker
(in bytes) before the Disk Free Limit alarm is tripped.

Disk Free Alarm - True or False. True indicates that the available disk space is
below the value set in Disk Free Limit and Security Analytics has stopped
accepting messages.

Memory Alarm - True or False. True indicates that the available memory is
below the value set in Memory Limit and Security Analytics has stopped

accepting messages.

Log Collector Details View

The Log Collector Details view provides information for the Log Collector. The following figure
depicts the Log Collector Details.
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RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Hea

eliness

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings RPN e I NWAPPLIANCE11639 @

OST AND SERVICES -
: ' Log Collector Details

Host

Service
| Log cottector

CPU 1% Used Meme 54.09 MB

Log Decoder o "
Running Since 2017-Jul-1210:23:15 Max Process Memory 31.42GB

Warehi nnector -

B S Build Date 2017-Jul-09 01:01:37 Version Information 11.0.00

Collection | Event Processing

Transport Protocol Status EPS Total Events Errors Warnings
checkpoint stopped 0 0 0 0 £

netflow stopped 0 o 0 0

file stopped 0 o 0 0

sdee stopped 0 0 0 0

odbe stopped 0 0 0 0
vmware stopped 0 0 0 0
syslog stopped 0 o 0 0
windows stopped 0 1] 0 0

| NETWITA

For the related procedure, see Monitor Service Details.

The lower section consists of the Collection and Event Processing tabs that display
generic statistics for the service.

Collection Tab

Displays the event collection statistics for each Log Collection protocol you have implemented
in NetWitness Suite (see the Log Collection Getting Started Guide in the Log Collection
Guides).

Event Processing Tab

Displays statistics for the NetWitness Suite internal event processing protocol (that is, the Log
Decoder) for Log Collection.

Parameter | Description

Transport NetWitness Suite protocol use for Log Collections (that is, the Log Decoder).

Protocol
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Status

EPS

Total Events
Errors
Warnings

Byte Rate

Status of the Log Decoder. Valid values are:

starting - Starting data capture (not capturing data yet).

o started - Capturing data.

« stopping- Stopping data capture (received request to stop data capture, but
not have not stopped capturing data yet).

« stopped - Not capturing data.

o disabled - Not configured as a Decoder service.

Rate (events per second) at which this the Log Decoder is processing events

from the Log Collector.

Total events processed by the Log Decoder.
Number of errors encountered.

Number of warnings encountered.

Current throughput in bytes per second.

Log Decoder Details View

The Log Decoder Details view provides information for the Log Decoder. The following figure
depicts the Log Decoder Details.
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RSA| RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings NWAPPLIANCE9 NWAPPLIANCE11639 @

HOST AND SERVICES
Log Decoder Details
Host
Service
Log Collector
CPU 23% Used Memory 1.73GB
I Log Decoder
Running Since 2017-Jul-1210:23:15 Max Process Memory 31.42GB
Warehouse Connector -
Build Date 2017-Jul-09 07:20:33 Version Information 11.0.0.0
Details
Capture Status started Packet Rate Max 1
Events Per Second 0 Pool Packet Capture 50000
Meta Rate o Pool Packet Assembler 0
Meta Rate Max 65 Assembler Packet Pages 0
Capture Dropped 0 Pool Packet Write 0
Capture Dropped Percent 0% Time Begin 2017-Jul-10 11:38:52
Time End 2017-Jul-12 11:36:58

11.0.0.0-1

For the related procedure, see Monitor Service Details.

This section displays the current generic statistics for the service.

Description

Capture Status of data capture. Valid values are:

Status o starting - Starting data capture (not capturing data yet).
o started - Capturing data.
 stopping - Stopping data capture (received request to stop data capture, but not
have not stopped capturing data yet).
 stopped - Not capturing data.
o disabled - Not configured as a Log Decoder service.
Packet Maximum per second rate at which the service is writing packets to the

Rate Max database. Rate is a rolling average sample over a short time period (10 seconds).
After the service stops capturing data, displays the maximum rate during data

capture.

Events Per Rate (events per second) at which the Log Decoder is processing events from the

Second Log Collector.
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Pool Number of packet pages available for capture.

Packet
Capture

Meta Rate Per second rate at which the service is writing metadata objects to the database.
Rate is a rolling average sample over a short time period (10 seconds). After the

service stops capturing data, rate is reset to zero.

Pool Number of packet pages waiting to be assembled.
Packet

Assembler

Meta Rate Maximum per second rate at which the service is writing metadata objects to the
Max database. Rate is a rolling average sample over a short time period (10 seconds).
After the service stops capturing data, displays the maximum rate reached during

data capture.

Assembler Number of packet pages waiting to be assembled.
Packet

Pages

Capture Number of packets reported by the network card as dropped. After the service

Dropped  stops capturing data, rate is reset to zero.

Pool Number of packet pages in the PCS pipeline that need to be written to the
Packet database.
Write

Capture Packets reported by the network card as dropped as a percentage.

Dropped

Percent

Time Time when first packet was captured (time when the first packet was stored in
Begin the packet database). This time increases as packets are rolled out of the packet

database.
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Description

Time End Time when the last packet was captured (time when packet was written to the

database). The time increases as new packets are captured.

Malware Details View

The Malware Details view provides information for Malware Analysis. The following figure
depicts the Malware Details.

Heal lIness

Monitoring Policies System Stats Browser  Event Source Monitoring Settings NWAPPLIANCE10604 NWAPPLIANCE22655 NWAPPLIANCE2943 @ | >

OST AND SERVICES -
e ' Malware Details

Host
Service

Broker
CPU Used Memg

I Malware Analysis id
Runining Since Max Process Memory
Build Date Version Information
Events VM

Number Of Events For Past 24 Hours
Number Of Files For Past 24 Hours
Number Of Events For Past 7 Days
Number Of Files For Past 7 Days

Number Of Events For Past Month

Average Processing Time
Events In Queue

Events Processed

Events Per Second Throughput

Session Time Of Last Event

Number Of Files For Past Month
Number Of Events For Past 3 Months

Number Of Files For Past 3 Months

NETWITNESS 11.0.0.0-170709005430.1.9127d8d

For the related procedure, see Monitor Service Details.

Displays the following event-related statistical information for the Malware Analysis service.

o Number of events for the past 24 hours
o Average processing time

o Number of files for the past 24 hours

o Events in queue

o Number of events for the past 7 days

o Events processed

o Number of events for the past 7 days

o Events per second throughput
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Number of events for the past month

o Session time of the last event
o Number of files for the past month

Number of events for the past 3 months

o Number of files for the past 3 months

Warehouse Connector Details View

The Warehouse Connector Details tab provides information for the Warehouse Connector, such
as the date it was built, CPU, and version information. The following figure depicts the
Warehouse Connector Details.

RSA RESPOND I TIGATE MONITOR CONFIGURE ADMIN

Health

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings NWAPPLIANCE11639 @

HOST AND SERVICES

Warehouse Connector Details

Host
Service
Log Collector
CPU 0% Used Memary 29.89 MB
Log Decoder : R
Running Since 2017-Jul-1210:23:15 Max Process Memory 31.42GB
Warehouse Connector
I Build Date 2017-Jun-29 11:21:49 Version Information 11.0.0.0
Details
Streams Complete Streams Running
Streams Incomplete Streams Stopped

Streams Total

11.0.0.0-170709005430.1.9127d8d

For the related procedure, see Monitor Service Details.

Policies View

The required permission to access this view is Manage services.

What do you want to do?

Administrator ~ View the policies NetWitness Server and Services Manage Policies
Administrator ~ Add, Edit, Duplicate, and Delete Policies Manage Policies
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Related Topics
Manage Policies
Quick Look

The figure depicts the Policies view.

RSA' RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Health &

ness

Alarms  Monitoring JEEGISESEN System Stats Browser  Event Source Monitoring  Settings

Policies T Admin Server: Admin Server Monitoring Policy |' 2 Save
+ ZI® ules and suppression schedules of Out-of-the-box policies cannat be directly modified. Duplicate the palicy if you wish to 5o modify them
B
V| Enable Last Modified: 2017-02-20 12:00:00 AM
4 Admin Server [ -
® Admin Server Monitoring Policy Services
¥ [ Archiver o Choose the hosts, services, and groups that your health policy applies to.
» [ Broker o +
» [ Concenrater o O name ~ Group Type
» [ Config Server o O A 10 Group
» [ Cantexchub Server o
Rules
» [ Decoder (1] Define the conditions under which yau want to trigger an alarm for the NetWitness Suite health proslems (definition includes sevarity, statistic the alarm applies to,
threshold, and threshold at which the alarm clears). After you define the alarm rule, enable or disable the alarm.
» [ Entity Behavior Analytics o
» [JEvent Stream Analysis )
b [ Host o L1 Enable Name ~ Severity Category Statistic Threshold
0 ® AdminServer.. Critica Processinfo Overall Processing Status Indicator  Alarm = ERROR for 2 MINUTES
» [JInvestigate Server )
a ® Admin Server... High Processinfo Overall Processing Status Indicator ~ Alarm = PARTIALLY_WORKING for 2 MINUTES
» [MLog Collector [ W hd

11.0.0.0-170709(

Bl Policies Panel

VAN Policy Detail Panel

1. Goto ADMIN > Health & Wellness.

2. Click the Policies tab.

Policies Panel

In the Policies panel, you can add or delete policies for hosts and services in this panel.

Description

+ - Displays available service types to create a new policy . Select one so that you

can define a policy or policies for it.

= Deletes the selected policy from the Policies panel. You can only delete one

policy at a time.

4 Allows you to change the name of the policy.
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o o

T:=J

b 13
AR

Creates a copy of the selected policy. For example, if you select First Policy and
click [B, NetWitness Suite creates a copy of this policy and names it First Policy

(1).

Expands the list of policies under the services and hosts in the Policies panel.

Contracts the list of policies under the services and hosts in the Policies panel.

List of:
o Services and hosts for which you have defined policies.

o RSA standard policies that you can apply to hosts and services.

Policy Detail Panel

The Policy Detail panel displays the policy selected from the Policies panel.

e Jowomn

Save
Policy Type

Modified
Date

[] Enable

Services

-+ -

Saves any changes you made in this panel.
Displays the type of policy you selected.

Displays the last date this policy was modified.

Select and deselect this checkbox to enable and disable the policy.

Displays menu in which you select:
o Groups to display the Groups dialog from which you select service groups to
this policy.

o Service/Host to display the Services/Hosts dialog from which you select
services to add to this policy. If policy type is Host, the menu will have Host

not Service. You can select services based on policy type.

Deletes the selected service or group from this policy.
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Rules

+ Displays the Add Rule dialog in which you define a rule for this policy.
- Deletes the selected rule from this policy.

4 Displays the Edit Rule dialog for the selected rule.

Policy Suppression

+ Adds a policy suppression timeframe row.

- Deletes the selected policy suppression timeframe row.

Time Zone  Selects the time zone for the Policy from the drop-down list. This time zone

applies to both Policy Suppression and Rule Suppression.

L] Selects the checkbox to select a policy suppression timeframe row.

Days Days of the week that you want to suppress the policy according to the time
range specified. Click on the day of the week that you want to suppress the

policy. You can select any combination of days including all days.

Time Time range during which the policy is suppressed for the days selected.
Range
Notifications
+ Adds an EMAIL notification row.
- Deletes the selected policy suppression timeframe row.

Notification Opens the Notification Servers view in which you can define the Email

Settings notification settings.

[ Selecting the checkbox selects a policy suppression time frame row.
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Output The type of notification defined on the Global Notifications page. Can be email,
SNMP, Syslog, or Script.

Recipient ~ The name of the person receiving the notification.

Notification Select the EMAIL notification server. See 'Configure Notification Servers' in
Server the System Configuration Guide for the source of the values in this drop-down

list.

Template Select the Template for this EMAIL notification. RSA provides the Health &
Wellness Default SMTP Template and the alarms template. See Configure
Notification Templatesin the System Configuration Guide for the source of the
other values in this drop-down list.

Note: Refer to Include the Default Email Subject Line if you want to include the
default Email subject line from the Health & Wellness template in your
Health & Wellness Email notifications for specified recipients.

Groups dialog

e e

Groups panel

Name Displays the service groups you have defined. You can select:

o All to display all your services in the Services panel.

o A group to display the services in comprise that group in the Services

panel.

Services panel

Name Displays the name of the service.
Host Displays the host on which the service is running.
Type Displays the type of service.
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Rules Dialog

o Jowemen

[] Enable

Name

Description

Severity

Statistic

Select and deselect this checkbox to enable and disable the rule for this policy.

Enter the name of the rule.

Enter the description of the rule. RSA suggests that you include the following
information in this field.

» Informational description - purpose of the rule and what problem it monitors.

. Remediation - steps to take to resolve the condition that triggers the alarm for
this rule.

Select the severity of the rule. Valid values are:

o Critical

o High

o Medium

o Low

Select the statistics you want to check with this rule. You can select:
« Statistical category from the left drop-down list.

« Statistic from the right drop-down list.

Note: For Public Key Infrastructure (PKI) policy, select PKI in the category
and statistics as any one of the following:

- NetWitness Server PKI Certificate Expiration - Displays the time left before
the certificate expires.

- NetWitness Server PKI CRL Expiration - Displays the time left before the
Certificate Revocation List (CRL) expires.

- NetWitness Server PKI CRL Status - Displays the current status of the CRL.

Please refer to the System Stats Browser View for examples of the statistics you
may want to check with a rule.
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Alarm Define the threshold of the rule that will trigger the policy alarm:

Threshold « Amount

Note: For CRL expiry the supported format is ddddhhmm, for example:
- 10000 represent 1 day

- 2359 represent 23 hours and 59 minutes

- 10023 represent 1 day and 23 minutes

- 3650100 represent 365 days and 1 hour

o Time in minutes
Recovery Defines when to clear the threshold of the rule:
o Operator:
o For NetWitness Suite 10.5 (5, !=, <, <=, >, or >=)
o For NetWitness Suite 10.5.0.1 and later (See Threshold Operators below)
o Amount

¢ Time in minutes

Rule Suppression

+ Selecting this option allows you to add a rule suppression timeframe row.

= Selecting this option allows you to delete the selected rule suppression time
frame row.

O Selecting the checkbox allows you to select a rule suppression time frame row.

Time Zone: Displays the Policy time zone. You select the time zone for a policy in the

time-zone  Policy Suppression panel.

Days Days of the week that you want to suppress the rule according to the time range
specified. Click on the day of the week that you want to suppress the rule. You

can select any combination of days including all days.

Time Time range during which the rule is suppressed for the days selected.

Range
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Threshold Operators

The Alarm Threshold and Recovery Threshold fields in the Rules dialog prompt you for

either numeric or string operators based on the statistic criteria you specify.

Numeric operators drop-down menu:

= W

InRange

lInRange

RSA Health & Wellness Email Templates

String operators drop-down menu:

o

Contains
!Contains
Regex Match
[Regex Match

notifications for specified recipients.

Note: Please refer to Include the Default Email Subject Line if you want to include the default
Email subject line from the Health & Wellness template in your Health & Wellness Email
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Health & Wellness Default SMTP Template

RSA NetWitness Suite

Health Alarm Notification

File Collection Service is off on HOST1000

State
Active

Severity
High

Host
HOST1000

Service
Log Collector

Alarmid
103-2248-0001

Policy
Check Point

Rule
File Collection Service is off

Statistic
Collection State

Value

stopped

Time
April 13, 2015 10:48:13 PM UTC
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Alarms Template

RSA NetWitness Suite

Health Alarm Notification

File Collection Service is off onHOST1000

State
Cleared

Severity
High

Host
HOST1000

Service
Log Collector

Alarmid
103-2248-0001

Policy
BootCamp Notification

Rule
Check Point Collection is off

Statistic
Collection State

Value
Policy-Disabled

Time:
April 14, 2015 2:31:21 AMUTC

NetWitness Suite Out-of-the-Box Policies

The following table lists the NetWitness Suite Out-of-the-Box Policies with the rules defined for
each policy.

You can perform the following tasks on any of these policies:

o Change service/group assignments.

o Disable/enable them.

You cannot perform the following tasks on any of these policies:

o Delete them.

« Edit Policy names.

Note: Additional information about the Out-of-the-Box Policies can be found in the User
Interface under
Health & Wellness — Policies.
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Policy Name Alarm Triggered

Communication Failure Host is down, Network is down, Message
Between Master Security Broker is Down, or Invalid or missing
Analytics Host and a security certificates for 10 minutes or more.

Remote Host
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Policy Name Alarm Triggered

Critical Usage on Rabbitmq  For var/1lib/rabbitmg, Mounted

NetWitness
Server
Monitoring

Policy

Message Broker Filesystem

Filesystem is Full

High Filesystem Usage

High System Swap

Utilization

High Usage on
Rabbitmq Message Broker

Filesystem
Host Unreachable

LogCollector Event
Processor Exchange

Bindings Status

LogCollector Event
Processor Queue with No

Bindings

LogCollector Event
Processor Queue with No

Consumers
Power Supply Failure

RAID Logical Drive
Degraded

Filesystem Disk Usage goes over 75%.

Overall Mounted Filesystem Disk Usage
reaches 100%.

Overall Mounted Filesystem Disk Usage

goes over 95%.

Swap Utilization goes under 5 % for 5

minutes or more.

Mounted Filesystem Disk Usage for

var/lib/rabbitmg goes over 60%.

Host down.

Issue with Log Collection Message Broker

Queues for 10 minutes or more.

Issue with Log Collection Message Broker

Queues for 10 minutes or more.

Issue with Log Collection Message Broker

Queues for 10 minutes or more.

Host not receiving power.

For Raid Logical Drive, Drive State equals

Degraded or Partially Degraded.
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Policy Name Alarm Triggered

NetWitness
Suite Archiver
Monitoring

Policy

RAID Logical Drive Failed

RAID Logical Drive
Rebuilding

RAID Physical Drive Failed

RAID Physical Drive

Failure Predicted

RAID Physical Drive
Rebuilding

RAID Physical Drive
Unconfigured

SD Card Failure

Archiver Aggregation
Stopped

Archiver Database(s) Not

Open

Archiver Not Consuming

From Service

Archiver Service in Bad

State

Archiver Service Stopped

For Raid Logical Drive, Logical
Drive State equals Offline, Failed, or
Unknown.

For Raid Logical Drive, Logical
Drive State equals Rebuild.

For Raid Physical Drive, Physical Drive
State does not equal Online, Online Spun

Up, or Hotspare.

For Raid Physical Drive, Physical Drive

Predictive Failure Count is greater than 1.

For Raid Physical Drive, Physical
Drive State equals Rebuild.

For Raid Physical Drive, Physical

Drive State contains Unconfigured(good).
SD Card Status does not equal ok.

Archiver Status does not equal started.

Database Status does not equal opened.

Devices Status does not equal consuming.

Service State does not equal started or

ready.

Server Status does not equal started.

References

144



System Maintenance Guide

Policy Name Alarm Triggered

NetWitness Broker >5 Pending Queries ~ Queries Pending greater than or equal to 5
Suite Broker for 10 minutes or more.
Monitoring

Broker Aggregation Stopped  Broker Status does not equal started.
Policy

Broker Not Consuming From Devices Status does not equal consuming.

Service

Broker Service in Bad State ~ Service State does not equal started or

ready.
Broker Service Stopped Server Status does not equal started.
Broker Session Rate Zero Session Rate (current) equals 0 for 2

minutes or more.
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Policy Name Alarm Triggered

NetWitness
Suite
Concentrator

Monitoring

Policy

Concentrator >5 Pending

Queries

Concentrator Aggregation

Behind >100K Sessions

Concentrator Aggregation

Behind >1M Sessions

Concentrator Aggregation

Behind >50M Sessions

Concentrator Aggregation

Stopped

Concentrator Database(s)

Not Open

Concentrator Meta Rate

Zero

Concentrator Not Consuming

From Service

Concentrator Service in Bad

State

Concentrator Service

Stopped

Queries Pending greater than or equal to 5

for 10 minutes or more.

Devices Sessions Behind is greater than or

equal to 100000 for 1 minute or more.

Devices Sessions Behind is greater than or

equal to 1000000 for 1 minute or more.

Devices Sessions Behind is greater than or

equal to 50000000 for 1 minute or more.

Broker Status does not equal started.

Database Status does not equal opened.

Concentrator Meta Rate (current) equals 0

for 2 minutes or more.

Devices Status does not equal consuming.

Service State does not equal started or

ready.

Server Status does not equal started.
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Policy Name Alarm Triggered

NetWitness
Suite Decoder
Monitoring

Policy

NetWitness
Suite Event
Steam Analysis
Monitoring

Policy

Decoder Capture Not Started Capture Status does not equal started.

Decoder Capture Rate Zero

Decoder Database Not Open

Decoder Dropping >1% of

Packets

Decoder Dropping >10% of

Packets

Decoder Dropping >5% of

Packets

Decoder Packet Capture
Pool Depleted

Decoder Service in Bad

State
Decoder Service Stopped

ESA Overall Memory
Utilization > 85%

ESA Overall Memory
Utilization > 95%

ESA Service Stopped

ESA Trial Rules Disabled

Capture Rate (current) equals 0 for 2

minutes or more.
Database Status does not equal opened.

Capture Packets Percent Dropped (current)

is greater than or equal to 1%.

Capture Packets Percent Dropped (current)

is greater than or equal to 10%.

Capture Packets Percent Dropped (current)

is greater than or equal to 5%.

Packet Capture Queue equals 0 for 2

minutes or more.

Service State does not equal started or

ready.
Server Status does not equal started.

Total ESA Memory Usage % is greater
than or equal to 85 %.

Total ESA Memory Usage % is greater
than or equal to 95 %.

Server Status does not equal started.

Trial Rules Status does not equal enabled.
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Policy Name Alarm Triggered

NetWitness IPDB Extractor Service in Service State does not equal started or
Suite IPDB Bad State ready.

Extractor

Monitoring IPDB Extractor Service Server Status does not equal started.
Policy Stopped

NetWitness Incident Server Status does not equal started.

Suite Incident Management Service

Management Stopped

Monitoring

Policy

NetWitness Log Collector Service Server Status does not equal started.

Suite Log Stopped

Collector _ .
Log Decoder Event Queue > Number of events currently in the queue is

Monitoring )
50% Full using 50% or more of the queue.

Policy

Log Decoder Event Queue > Number of events currently in the queue is

80% Full using 80% or more of the queue.

Log Collector Service in Bad Service State does not equal started or

State ready.
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Policy Name Alarm Triggered

NetWitness
Suite Log
Decoder
Monitoring

Policy

NetWitness
Suite Malware
Analysis
Monitoring

Policy

Decoder Dropping>10% of
Packets

Log Capture Not Started

Log Decoder Capture Rate

Zero

Log Decoder Database Not
Open

Log Decoder Dropping >1%
of Logs

Log Decoder Dropping >5%
of Logs

Log Decoder Packet Capture
Pool Depleted

Log Decoder Service

Stopped

Log Decoder Service in Bad

State

Malware Analysis Service

Stopped

Capture Packets Percent Dropped (current)

is greater than or equal to 10%
Capture Status does not equal started.

Capture Rate (current) equals 0 for 2

minutes or more.

Database Status does not equal opened.

Capture Packets Percent Dropped (current)

is greater than or equal to 1%.

Capture Packets Percent Dropped (current)

is greater than or equal to 5%.

Packet Capture Queue equals 0 for 2

minutes or more.

Server Status does not equal started.

Service State does not equal started or

ready.

Server Status does not equal started.
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Policy Name Alarm Triggered

NetWitness
Suite Reporting
Engine
Monitoring

Policy

Reporting Engine Alerts

Critical Utilization

Reporting Engine Available
Disk <10%

Reporting Engine Available
Disk <5%

Reporting Engine Charts

Critical Utilization

Reporting Engine Rules

Critical Utilization

Reporting Engine Schedule
Task Pool

Critical Utilization

Reporting Engine Service

Stopped

Reporting Engine
Shared Task

Critical Utilization

Alerts Utilization is greater than or equal to

10 for 5 minutes or more.

Available disk space is less than 10%.

Available disk space is less than or equal

to 5%.

Charts Utilization is greater than or equal to

10 for 5 minutes or more.

Rules Utilization is greater than or equal to

10 for 5 minutes or more.

Schedule Task Pool Utilization is greater

than or equal to 10 for 15 minutes or more.

Server Status does not equal started.

Shared Task Pool Utilization is greater than

or equal to 10 for 5 minutes or more.
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Policy Name Alarm Triggered

NetWitness Warehouse Connector Service State does not equal started or
Suite Service in Bad State ready.
Warehouse
Warehouse Server Status does not equal started.
Connector .
Connector Service Stopped
Monitoring
Policy Warehouse Stream Behind is greater than or equal to
Connector Stream Behind 2000000.
Warehouse Stream Disk Usage (Pending Destination
Connector Stream Disk Load) is greater than or equal to 75.
Utilization > 75%
Warehouse Connector Stream Status does not equal consuming or
Stream in Bad State online for 10 minutes r more.
Warehouse Connector Number of files in the permanently rejected
Stream Permanently files is greater than or equal to 300.
Rejected Files > 300
Warehouse Connector Rejected folder usage is greater than or
Stream Permanently equal to 75%.
Rejected Folder > 75% Full
NetWitness Workbench Service in Bad ~ Service State does not equal started or
Suite State ready.
Workbench
Monitoting Workbench Service Stopped  Server Status does not equal started.
Policy

System Stats Browser View

NetWitness Suite provides a way to monitor the status and operations of hosts and services. The
System Stats Browser tab displays key statistics, service system information, and host system
information for a host or service.

You can customize the stats view depending on the parameter you select to filter the data.
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To access the System Stats Browser view:

1. Goto ADMIN > Health & Wellness.
The Health & Wellness view is displayed with the Alarms tab open.

2. Click the System Stats Browser tab.

What do you want to do?

Administrator ~ View the System Stat Historical Graph Historical Graph for System Stats

Related Topics

Monitor Service Statistics

Filter System Statistics

View Historical Graph of System Statistics

Quick Look

The System Stats Browser view is displayed.

ADMIN

Monitoring Policies Systemn Stats Browser JRSGUST e LT Settings

2
Host Component Category Statiszic Order By .

Ay v | Any v Ay ~ Clear
Regex [MRegex ®Ascending (Dewending
Host Component Category Statistic Subitem Value Last Update Historical Graph
ocalhost localdomain Host FileSystem Error Status o 2017-05-17 05:32:38 PM ]
h
ocalhost localdomain Host FileSystem Mounted Filesystem Disk Usage fdev 2017-05-17 05:32:38 PM &
ocalhast localdomain Host FileSystem Mounted Filesystemn Disk Usage Isysffslcgroup 2017-05-17 05:32:38 PM &
ocalhost localdomain Host FileSystem Mounted Filesystem Disk Usage frun 53238 PM o
ocalhast localdomain Host FileSystem Mounted Filesystem Disk Usage 335 PM h
alhost localdomain o eSyste ounted 1 D 3 d n 32:38 PM &
alt ) nal 1 Sy u 1 D ) hom 28 PM &

Displays System Stats Browser View

Toolbar used to filter and customize the System Stats Browser View

Filters

This table lists the various parameters you can use to filter and customize the System Stats view.
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Host Select a host from the drop-down menu to display the stats of the selected host.

Select Any to list all the available hosts.

Component  Select a component from the drop-down menu to display the stats for the
selected component.

Select Any to list out all the components on a selected host.

Category Type the category to display the stats for the required category.
Select Regex to enable Regex filter. It performs a regular expression search
against text and lists out the specified category. If Regex is not selected it

supports globbing pattern matching.

Statistic Type the statistic to display the required statistic on all the hosts or
components.
Select Regex to enable Regex filter. This performs a regular expression
search against text and lists out the specified category. If Regex is not selected

it supports globbing pattern matching.

Order By Select the order in which the list needs to be filtered.

Select Ascending to filter the list it in an ascending order.

Commands

CE .
Apply Click to apply the filters chosen and display the list accordingly.
Clear Click to clear the chosen filters.

System Stats View Display

Displays statistics, service system information, and host system information for a host or
service.

Access Stats Details
Select one of the stats and click Stats Details on the right hand side of the panel.

The Stats details panel opens with details of the selected stats.
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Stat Details
Host
Hostname
Component 1D
Component
MName

Subitem

Path

Plugin

Plugin Instance
Type

Type Instance

Description

Category

Value

Raw Walue

Graph Data Key

ast Updated Time

14e552322-12ba-42f2-2376-2022ebed0003
MWAPPLIAMCETDE04

appliance

Host

Mounted Filesystem Disk Usage
/devishm

appliance_df
dev_shm

fs_usage

Disk usage information for meounted filesystem
Jdevishm

FileSystem
20170714 03:11:18 PM
15.71 GE size, 12,00 KB used, 15.71 GB available

1.686%943792E10 bytes size, 12285.0 bytes used,
1.6868445652E10 bytes available

14855322.12ba-4af2-a376-
20aZebed9993/appliance_df-dev_shm/fs_usage

Stat Key 14e55222-12ba-4af2-3376-
80azebe49993/appliance_df-dev_shm/fs_usage

stat_collector_wersion 11.0.0.0

Filasystam tmpfs i

System View - System Info Panel

This topic describes the System Information panel, which displays information about the system
version and license status.

The required role to access this view is Manage System Settings.

To access this view, do one of the following:

¢ Goto ADMIN > System.
The System Information panel is displayed by default.

o When you receive a notification that a new version of NetWitness Suite is available in the

Notifications tray, click View.
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RSA RESPOND

INVESTIGATE MONITOR CONFIGURE ADMIN (01) admin =

| Infa
Updates
Licensing
Email
Global Motifications
Legacy Motifications
System Logging
Global Auditing
Jobs
Live Services

URL Integration

Version Information

Current Version 11.0.0.0-
170917005224.1. daacdd2

Current Build 170917005424
License Sarver ID 005056014585
License Status Enabled Disable

Context Menu Actions

Investigation

ESA

ESA Analytics

Whois

HTTP Proxy Settings

NTP Settings

| NETWITNE

The Version Information section displays version information about the version of NetWitness
Suite that is currently installed. The following table describes the features of the Version
Information section.

Description

Displays the version of Security Analytics that is currently running. The format of

the version is major-relase.minor-release.stability-id. build-number. Possible values

for the stability-id are:

Current  ®

Version o

1 - Development
2 - Alpha

3 - Beta

4-RC

5 - Gold
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v

Current  Identifies the current build revision for use in troubleshooting situations.
Build
Each client host is shipped with the Local Licensing Server (LLS) installed to
License manage host licenses. This field indicates whether the LLS is installed for this
Server  Instance of Security Analytics.
ID o When the LLS is installed, the Licensing Server ID is displayed.
o Unknown indicates that the LLS is not installed.
Indicates whether or not the license is enabled. If the license is:
License Enabled, Enabled is displayed in this field and there is a Disable button to the
right so you can disable it.
Status ghtsoy
o Disabled, Disabled is displayed in this field and there is an Enable button to the
right so you can enable it.
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System Updates Panel - Settings Tab

System Updates Settings tab describes the interface you use to set up a connection to Live
Update Repository. These settings ensure that the NetWitness Suite can reach the Live Update
Repository and synchronize it with your Local Update Repository.

The required permission to access this view is Apply System Updates.

To access this view:

1. Goto ADMIN > System.

2. Select Updates.

What do you want to do?

Administrator Automatically download Enable automatic synchronization with the RSA
updates update repository.

Related Topics

Managing NetWitness Suite Updates

Quick Look

The System Updates Settings panel is displayed.

Info

System Updates Settings

I Updates t H Configure Live account (required) ¢ E
. " Configure proxy settings
Licensing Bure proxy setings

, [ Automatically download information about new updates every day
Emai

Appl
Global Notifications

Legacy Notifications

System Logging

Laleal B chis

Displays System Update Setting Tab
Configure Account and Setting for Automatic Updates

Features

This table describes the features in the System Updates Settings panel.
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CE

Configure Live account Displays the ADMIN > System >
Live Services panel in which you can
configure your Live Account
credentials if they are not configured.

Configure proxy settings Displays the ADMIN > System >
HTTP Proxy Settings panel in which

you can configure an HTTP proxy if it
is not configured.

Automatically download Select to enable automatic
information about new synchronization with the RSA update
updates every day repository. If there are new updates

available, information will
automatically be displayed in the
ADMIN > HOSTS panel.

Apply Applies the settings in this tab.

System Logging - Settings View

The RSA NetWitness SuiteSettings view in the System Logging panel configures the size of the
log files, the number of backup log files maintained, as well as the default logging levels for the
packages within NetWitness Suite. The Configure Log File Settings topic in the System
Configuration Guide provides detailed procedures.

To access the Settings tab:

1. Goto ADMIN > System.

2. In the options panel, select System Logging.
The System Logging panel opens to the Realtime tab by default.

3. Click the Settings tab.

What do you want to do?

Administrator ~ Configure the size of the Log files Setup the Log Settings Toolbar
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Related Topics

System Logging - Historical Tab

System Logging - Realtime Tab

Quick Look

RSA RESPOND

Info

Updates

Licensing

Email

Global Notifications

Legacy Notifications

| system Loggmg‘._n

INVESTIGATE

MONITOR  CONFIGURE ADMIN

System Logging

settings ‘—E

Realtime | Historical

Log Settings
Max Log Size 4194304

Max # Backup Files 9

¥ Show Error Stack Trace

Global Auditing Apply
Jobs
Live Services Package Conf guration
URL Integration 80com
Context Menu Actions B Connection
Investigation I Darohccess
Beu

ESA

& For
Ve B[ Jfreemarker
Whois B[ Yjsvax
HTTP Proxy Settings B03ne
NTP Settings B00r

B Security .

NETWITNESS SUITE

Displays System Logging Panel

Displays Settings Tab

The section allows the user to configure Log Settings
The section allows the user to configure Package

Features

The Settings tab has two sections: Log Settings and Package Configuration.

Log Settings

The Log Settings section configures the size of the NetWitness Suite log files and the number of
backup logs that NetWitness Suite maintains.

N =

Max Log Size Configures the maximum size in bytes of each log file. The

minimum value for this setting is 4096.
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e o

Max # Backup Files Specifies how many backup log files are maintained. The

minimum value for this setting is 0. When the maximum number of
log files is attained, and a new backup file is made, the oldest

backup is discarded.

Show Error Stack Trace  geJect checkbox to display ERROR, STACK, and TRACE log

Apply

messages.

Puts the settings into effect immediately for all future logs.

Package Configuration

The Package Configuration section shows the NetWitness Suite packages in a tree structure.

Foawrs peserptor

Package

tree

Package
field

Log Level

Reset
recursively
Apply

Reset

The tree contains all the packages used within NetWitness Suite. You can drill

down into the tree to view the log levels of each package.

The root logging level represents the default log level for all packages that are

not explicitly set. The root level is set to INFO

This field is populated with the name of the selected package when you select a

package in the Package tree.

If the selected package has a log level explicitly set, the value is displayed in the
Log Level field.

Select checkbox to reset the log recursively.

This button puts the settings into effect immediately for all future logs.

This button resets the selected package to the log level of root.
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System Logging - Realtime Tab
This topic describes the features of the System Logging > Realtime tab and the Services Logs
view > Realtime tab.

The Realtime tab is a view of the NetWitness Suitelog or a service log. When it is initially
loaded, the view contains the last 10 log entries. As new entries become available, the view is
updated with those entries.

To access the Realtime tab:

1. Goto ADMIN > System.

2. In the options panel, select System Logging.
The System Logging panel opens to the Realtime tab by default.

What do you want to do?

Administrator See details of Log entry Displaying System and Service Logs

Related Topics

System Logging - Settings View

System Logging - Historical Tab
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Quick Look

The following is an example of the Realtime tab in the System Logging panel.

RSA RESPOND  INVESTIGATE MONITOR CONFIGURE ADMIN @!admm C

System

Info

Updates h

Realtime | Historical Settings

tem Logging

Licensing
ALL V| Keywords Search
Email
Timestamp Level | Message
Global Notifications

Host has not received update, resex

Legacy Notifications

Global Auditing

Jobs

Live Services

URL Integration
Context Menu Actions
Investigation

ESA

ESA Analytics
Whois
HTTP Proxy Settings

NTP Settings

‘ NETWITNESS SUITE 021190852.1.1bbc535

. Displays System Logging Panel
Displays Realtime Tab

The following is an example of the Realtime tab in the Services Logs view, which is similar.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN @admm G @

H Services
% Change Service | I Broker -Broker |
Svstem Logging
System Logging
Realtime Historical
ALL v || Keywor Broker v || Search

Message

Broker r

e C=US, ST=VA, L= Reston, O = RSA, OU = Nec

User admin has

User admin has

| NETWITN
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Features

The Realtime tab has a toolbar with input fields to allow filtering of the entries, and below the
toolbar is a grid containing the log entries.

Toolbar

Feawrs _Jowserpten

Log Level drop- Selects the log level for entries to display in the grid. The Log Level drop-

down down shows the available log levels for the system or the service.
ALL - . System logs have seven log levels.
ALL
TRACE o Service logs have only six log levels because they do not include the
DEBLUG TRACE level.
INFO o The default is ALL log entries.
WARN
ERROR
FATAL

Keywords field Specifies a keyword to use when filtering entries. This field is the same

for system and service log filtering.

Service field  Specifies the service type to use when filtering service log entries.
(Service Logs  Possible values are the host or the service.

only)

Filter button Click to activate filtering based on the log level, keyword, and service

selections.

Log Grid Columns

Timestamp This is the timestamp for the entry.
Level This is the log level for the message.
Message This is the text of the log entry.
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System Logging - Historical Tab

The Historical tab provides a searchable view of the NetWitness Suite log or the service log in a
paged format. When initially loaded, the grid shows the last page of the log entries for the
system or the system.

To access the Historical tab:
1. Goto ADMIN > System.
2. In the options panel, select System Logging.
The System Logging panel opens to the Realtime tab by default.

3. Click the Historical tab.

What do you want to do?

Administrator View the Historical Graph Historical Graph for System Stats

Related Topics

System Logging - Realtime Tab

System Logging - Settings View
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Quick Look

The following is an example of the Historical tab in the System Logging panel. It shows the
NetWitness Suite logs.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN L,‘l @lsdmmv

e System Log
Updates
poa Realtime fistc
Licensing
v Keywords Search
Email

Level  Message

Global Notifications

INFO Valid entitlements not f

Legacy Notifications

Inr-vm gin, ‘_

Global Auditing

INFO Looking for valid enti
INFO Valid entitlements not f

NFO  Looking fo

Valid entitlements not f
Jobs

Live Services

URL Integration
Context Menu Actions
nvestigation

ESA

ESA Analytics

Whois

alware - Malware An.

HTTP Proxy Settings

201

« € | Page

NTP Settings

Displaying

NETWITH

Displays System Logging Tab
Displays Historical Tab

The following is an example of the Historical tab in the Services Logs view. It shows the

services logs.

RSA| RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN @admm o

Services

5 Change Service | I Broker-Broker |  Logs

System Logging
Realtime | Historical

v || keywards Broker ~ | Search 7 export

Timestamp Level  Message

kup and ntand 5 params with ...

ith pa

select * where ip.ds s &8 ip.sre exists’

et * where country

User admin (s 1463572, 10.31.204.145:47288) has i

, 10.31.204.145

Displaying 9951 - 10000 of 1
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Features

The Historical tab has a toolbar with input fields to allow filtering of the entries, a grid
containing the log entries, and paging tools.

o o —

Start The Start Date and End Date range search options limit the log entries to a point
Date and in time. When used, you must provide both a start and end date. The times are
End Date optional. The date range is validated to assure that the end date is not before the

start date.

Log Selects the log level for entries to display in the grid. The Log Level drop-down

Level shows the available log levels for the system or the service.
o System logs have seven log levels.

o Service logs have only six log levels because they do not include the TRACE

level.

o The default is ALL log entries.

Keyword Specifies a keyword to use when filtering entries. This field is the same for

field system and service log filtering.

Service  Specifies the service type to use when filtering service log entries. Possible values
field are the host or the service.

(Service
Logs
only)

Search  Click to activate a search based on the start and end date, log level, keyword, and

button  service selections.

Export  Click to export the currently viewed grid entries to a text file. You can select

either comma-separated or tab-separated format for the entries in the file.
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Timestamp This is the timestamp for the entry.
Level This is the log level for the message.
Message This is the text of the log entry.

The paging tools below the grid provide a way to navigate through the pages of log entries.

| Page 1 |of16 | » »IC

Search Log Entries

To search the results shown in the Historical tab:

1. (Optional) Select a Start Date and End Date. Optionally, select a Start Time and End

Time.
2. (Optional) For system and service logs, select a Log Level and a Keyword, or both.
3. (Optional) For service logs, select the Service: host or service.

4. Click Search.
The view is refreshed with the most recent 10 entries matching your filter. As new matching

log entries become available, the view is updated to show those entries.

Show Details of a Log Entry

Each row of the Historical tab Log grid provides the summary information of a log entry. To
view complete details:
1. Double-click a log entry.
The Log Message dialog, which contains the Timestamp, Logger Name, Thread, Level and
Message, is displayed.
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Log Message

Timestamp 2017-09-27T09:22:02.505

Logger Name Index
Thread
Level INFO

Message Indexes are being initialized

2. When finished viewing, click Close.

Page Through the Entries

To view the different pages of the grid, use the paging controls on the bottom of the grid as
follows:

o Use the navigation buttons

o Manually enter the page you want to view, and press ENTER.

Export

To export the logs in the current view:

Click Export, and select one of the drop-down options, CSV Format or Tab Delimited.

The file is downloaded with a filename that identifies the log type and the field delimiter. For
example, a NetWitness Suite system log exported with comma-separated values is named UAP_
log_export CSV.txt, and an appliance log exported with tab-separated values is named
APPLIANCE log_export TAB.txt.
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